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Abstract 

 

Peatlands are extremely complex and sensitive ecosystems, capable of releasing vast amounts of 

methane in response to disturbance events. To date, little advancement has been made by 

researchers to quantify the impact of small-scale anthropogenic disturbances on these ecosystems, 

specifically seismic lines. These “low-impact” linear features present a challenge to researchers as 

they exist at dimensions too small for the majority of remote-sensing platforms to successfully 

identify and measure, even though they account for a considerable portion of land disturbance in 

Canada’s western Boreal, and are anticipated to have extensive, compounding environmental 

effects. This thesis summarizes how unmanned aerial vehicle photogrammetry can be used to 

address this knowledge gap by showcasing the ability to generate accurate peatland terrain models, 

and subsequently estimate seismic-line impacts on both physical parameters (microtopography and 

depth-to-water) and peatland methane emission, ultimately revealing one of the hidden impacts of 

seismic lines on Canada’s Boreal peatlands. 
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Preface 

This is a manuscript-based thesis prepared in accordance with the Faculty of Graduate Studies 

Guidelines at the University of Calgary. Chapter 2 was published in the open-access, peer-

reviewed journal Remote Sensing, and has been reproduced under copyright agreement with the 

publisher MDPI. Chapter 3 was submitted to the peer-reviewed journal Journal of Geophysical 

Research: Biogeosciences on October 18, 2017 and is currently in review. I am intellectually 

responsible for the majority of works presented in this thesis, including research design, data 

collection, analysis, graphical preparation, and writing. Research presented in Chapter 2 was 

completed primarily by myself, whereas Chapter 3 presents more collaborative work, 

incorporating data prepared by various project partners in the analysis. Dr. Tak Fung with the 

University of Calgary assisted with statistical analysis presented in Chapter 2. The methane flux 

data used in Chapter 3 was collected, analyzed, and methods summarized by project colleague 

Saru Saraswati, a current PhD candidate with the University of Waterloo. The depth-to-water table 

used in Chapter 3 was generated, assessed and methods summarized by project colleague Mir 

Mustafizur Rahman, the project research technician at the University of Calgary. Dr. Rahman also 

assisted with data processing. Figure 3.5 in Chapter 3 was prepared in collaboration with Robin 

Poitras, a cartographer within the Department of Geography at the University of Calgary. Dr. 

Gregory McDermid (University of Calgary), Dr. Maria Strack (University of Waterloo), and Dr. 

Bin Xu (NAIT) assisted in developing overall research design and logistics, and have reviewed 

final drafts of the articles prior to journal submission.    

The vast majority of research focusing on seismic line disturbances within Boreal peatlands 

has described impacts primarily in terms of habitat fragmentation or suitability, rather than 
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peatland carbon cycling and storage functions. In fact, no previous research describing the 

greenhouse-gas impacts of the ubiquitous linear-disturbance features within Boreal peatlands of 

western North America could be located. Therefore, the research and published works presented 

here represents my attempt to address this identified knowledge gap within the literature, and 

contribute meaningful data and methods for future studies to expand upon. The full and anticipated 

citations are as follows: 

 

Chapter 2: Lovitt, J., Rahman, M.M., & McDermid, G.J. (2017). Assessing the Value of UAV 

Photogrammetry for Characterizing Terrain in Complex Peatlands. Remote Sensing. 9(7): 715. 

 

Chapter 3: Lovitt, J., Rahman, M.M., Saraswati, S., McDermid, G.J., Strack, M., & Xu, B. (2017). 

UAV Remote Sensing Can Reveal the Effects of Low Impact Seismic Lines on Methane (CH4) 

Release in a Boreal Treed Bog. Journal of Geophysical Research: Biogeosciences. [In Review]. 
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Chapter One: Introduction 

 
1.1 Overview 

Peatlands are recognized as globally important ecosystems due to their role as regional hydrology 

regulators, biodiversity hotspots, and massive carbon stocks; containing approximately 30% of the 

Earth’s terrestrial soil carbon (Parish et al., 2008; Joosten & Couwenberg, 2009; FAO, 2014). The 

vast majority of peatlands by area are concentrated within the northern latitudes, specifically 

within the Boreal Forest/Taiga biome, and coincide with the largest soil-organic carbon stocks 

(Wieder & Vitt, 2006; Strack, 2008; Parish et al., 2008; Scharlemann et al., 2014). Anoxic 

decomposition of organic matter within peatlands produces large amounts of methane gas (CH4): 

a powerful greenhouse gas (GHG) that has approximately 28 times the global warming potential 

of CO2 (Joosten & Couwenberg, 2009; Bridgham et al., 2013; FAO, 2014; Zhu et al., 2014). 

Wetlands are the largest natural source of CH4, and a wealth of research has identified strong links 

between climatic conditions and wetland CH4 release rates (Bridgham et al., 2013; Turetsky et al., 

2014). The balance between environmental factors (hydrology, vegetation, chemistry, climate etc.) 

within northern peatlands is delicate and sensitive to disturbance events, which may trigger an 

ecological shift from peatlands serving as carbon sinks to carbon sources (Wieder & Vitt, 2006; 

Strack & Waddington, 2007; Parish et. al., 2008; Eppinga et al., 2009; Vitt & Bhatti, 2012; Strack 

& Waddington, 2012; Munir et al., 2014).  In particular, anthropogenic disturbance of these 

sensitive ecosystems may alter environmental conditions to such a degree that CH4 emissions 

increase exponentially within disturbed areas (Dabros et al., 2017). In the Boreal region of Alberta, 

petroleum resource exploration has resulted in the construction of a dense network of seismic lines, 

many of which intersect low-lying peatlands (Lee & Boutin, 2006; Schneider & Dyer, 2006; van 
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Rensen et al., 2015). Studying the impact of these linear features on the landscapes they traverse 

has proven to be a difficult task, as they exist in predominately remote locations unsuitable for 

access by foot, cross numerous ecosystem types, and generally occur at scales too small for many 

remote-sensing platforms (ie. satellites) to observe. As a result, the impact of seismic lines on 

peatland CH4 emission rates is largely unknown, and has yet to be quantified accurately at any 

scale (ie. local, regional, or provincial).  

Unmanned aerial vehicles (UAVs) are remote-sensing platforms capable of collecting 

ultra-high resolution aerial imagery over large areas, and offer a desirable alternative to traditional 

ground-survey methods, which are more costly and labour-intensive (Knoth et. al., 2013; 

Roosevelt, 2014). For example, high-density photogrammetric point clouds and orthophotography 

generated from UAV data are ideal for investigating small-scale surface features such as peatland 

microtopography, CH4 hotspots, and linear disturbances like seismic lines (Pirotti & Tarolli, 2010). 

Several studies have indicated that these platforms are well-suited to mapping peatland terrain in 

high detail when canopy is sparse (Lucieer et al., 2014; Roosevelt, 2014; Turner et al., 2014; 

Lehmann et. al., 2016), however their applicability within the more complex, treed peatlands 

common to western Canada has yet to be tested.  

This thesis endeavors to describe UAV capabilities in modelling complex peatland terrain, 

and to demonstrate how these models can be used to quantify seismic-line impacts on both peatland 

CH4 release, and surface structure: specifically microtopography and depth-to-water. The research 

presented here discusses data collected from one study site – a treed bog in northwestern Alberta 

– and is not anticipated to represent all cases of peatland-seismic disturbance within the province. 

However, it does present the first-known estimation of seismic-line impacts within a peatland 
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complex, and is anticipated to serve as a stepping stone for future research, and perhaps to assist 

regulators in developing mindful land-use policies within western Canada’s Boreal region.  

This introductory chapter outlines pertinent knowledge gaps and provides essential 

background information to prepare the reader for subsequent chapters. It presents a number of 

topics, including (i) a brief description of peatlands in western Canada and their global significance 

(ii) natural controls on peatland greenhouse-gas emissions and general response to disturbance 

events, and (iii) the potential applications of quantifying seismic-line impacts on peatlands using 

UAV technology. 

 
1.2 Background  

Peatlands are a class of wetland which cover approximately 400 million hectares (roughly 3%) of 

the Earth’s surface, and can be found on all continents (Wieder & Vitt, 2006). Peatlands can be 

loosely defined as resource‐ or nutrient‐limited ecosystems which contain a naturally occurring 

surface‐peat soil layer of a given thickness (>40cm in Canada; National Wetlands Working Group 

[NWWG], 1997; Farmer et. al., 2011; ESRD, 2015). The vast majority of peatlands occur within 

the Boreal Forest/Taiga biome of northern latitudes, which contain the largest soil-organic carbon 

stocks (Wieder & Vitt, 2006; Strack, 2008; Parish et al., 2008; Scharlemann et al., 2014). 

Conservative estimates, incorporating mean peat depth, predict 547 gigatons of carbon (GtC) to 

be currently stored within northern Boreal peatlands (Yu et. al., 2010). Due to the amount of 

terrestrial soil carbon stored within these northern peatlands, and the noted link between carbon 

release and ecosystem disturbance (Wieder & Vitt, 2006; Parish et al., 2008; Eppinga et al., 2009), 

it has become essential to incorporate peatland carbon-stock estimates within global climate-

change models (Yu, 2012; Shi et. al., 2015). Consequently, it has become equally important to 
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improve the accuracy of models predicting peatland response to disturbances anticipated by 

climate-change models (Strack et. al., 2006).  

Globally, carbon dioxide (CO2) has been identified as the most important greenhouse gas 

(Bridgham et. al., 2013). However within northern Boreal peatlands, CO2 emissions are generally 

low as it is produced through aerobic decomposition, and the elevated water table of these 

ecosystems result in primarily anaerobic conditions and CO2 sequestration (Limpens et. al., 2008). 

Conversely, the resultant anoxic decomposition of organic matter generates large amounts of 

methane gas (CH4): a powerful GHG having approximately 28 times the global warming potential 

of CO2 (Joosten & Couwenberg, 2009; Bridgham et. al., 2013; FAO, 2014; Zhu et al., 2014). 

Wetlands are the largest natural source of CH4, and previous research has identified strong links 

between climatic conditions and wetland methane release rates (Bridgham et. al., 2013; Turetsky 

et. al., 2014). As such, there is currently great interest in identifying factors which contribute to 

CH4 production within wetland ecosystems (Bridgham et. al., 2013). 

 
1.2.1 Peatlands within Canada and Alberta. 

An estimated 147 million tonnes of soil carbon is thought to be stored within Canadian 

Boreal peatlands, accounting for 56% of organic carbon stored within all Canadian soils (Strack, 

2008).  Canada contains approximately 24% of the Earth’s wetlands, and approximately 28% of 

the Earth’s peatlands by land area (NWWG, 1997; Strack, 2008). The vast majority of Canada’s 

peatlands are found within the Boreal forest region, which covers approximately 113.6 million 

hectares (12%) of the country’s landmass, including portions of all three coastlines (Strack, 2008). 

Although peatlands are found throughout the Canadian Boreal forest, two major hotspots of 

peatlands are apparent: (i) the Hudson Bay Lowlands in eastern Canada, and (ii) the 
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intercontinental peatlands of interior BC, NWT, and the prairie provinces (Figure 1.1). These two 

areas are vastly different in climate, hydrology, chemistry, substrate, and vegetation, which has 

led to the evolution of dissimilar peatland complexes (Rochefort et al., 2012). Perhaps the most 

obvious difference between eastern and western Canadian Boreal peatlands is the presence of trees. 

While trees are common in western Canadian peatlands, most eastern Canadian peatlands are open, 

treeless ecosystems (Rochefort et al., 2012; Munir et al., 2014). Trees are sustained within western 

ecosystems by fairly dry climatic conditions, where potential evapotranspiration nearly equals 

annual precipitation measurements (Vitt & Bhatti, 2012). However, these dry conditions also lead 

to intermittent fire disturbances (Strack, 2008).  

   

Figure 1.1: Comparison of Mer Bleue (Left, foreground) a well-researched bog near Ottawa, 
Ontario (retrieved from Kalacska et al., 2013), and a view of our study site (Right) located near 
Peace River, Alberta. Peatlands in western Canada are capable of sustaining tree growth, as is 
apparent in the images.  

 
1.2.1.1 Peatland Microtopography. 

Microtopography describes small-scale heterogeneities in ground elevation and surface 

structure across a peatland (Cresto Aleina et al., 2015). These features can be referred to as 

microforms, and are visibly identifiable when patterns become apparent, often occurring around 

the 1m x 1m scale (Belyea & Malmer, 2004; Eppinga et al., 2009; Cresto Aleina et al., 2015). 
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Although a variety of terms exist to describe microforms, two terms are consistently used in the 

literature: hummocks and hollows (Belyea & Malmer, 2004; Couwenberg & Joosten, 2005; Strack 

& Waddington, 2007; Eppinga et al., 2009; Acharya et al., 2015). Hummocks are areas where 

organic matter has accumulated over a relatively small spatial scale, creating a small hill in the 

landscape (Pouliot et al., 2011). Hollows are the opposing, low‐lying areas dispersed between 

hummocks (Figure 1.2) (Nungesser, 2003).    

    
 

Figure 1.2: Examples of microforms. In the left pane a hollow is displayed as a hole in the 
surrounding vegetation and moss. In the right pane, a hummock is displayed as a clear moss 
mound, which rises above the surrounding peat surface. Both of these features occur at the sub-
meter scale. Images were provided by project colleagues. 

 
Microforms have been shown to provide a variety of important environmental functions, 

including hydrological regulation by improving water retention within peatlands, as well as 

controlling spatial distribution of GHG fluxes, microclimates, and nutrient gradients (Lucieer et 

al., 2010; Macrae et al., 2013; FAO, 2014; Cresto Aleina et al., 2015; Acharya et al., 2015). Once 

established, peatland microforms may persist for decades in the landscape under equilibrium 

environmental conditions (Nungesser, 2003). Thus within disturbed peatlands, apparent changes 
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in vegetation community or microtopographic features surrounding the disturbance may be 

accredited to the disturbance event rather than natural factors. 

The research community has yet to reach consensus on the exact combination of 

environmental factors responsible for peatland microform formation, distribution, and resiliency. 

Some sources indicate variations in soil moisture, hydroperiod, and depth to water table are 

primarily responsible, while others indicate that the spatial distribution of Sphagnum species and 

differences in intrinsic decomposition rates drive microform patterning (Hogg, 1993; Nungesser, 

2003; Strack, 2008; Acharya et al., 2015).  

 
1.2.1.2 Controlling Factors of Peatland Methane Emission. 

Methane is generated in saturated soils under highly reduced conditions. Therefore, the rate 

of CH4 emission within a peatland (flux) has been strongly linked to water-table position below 

the peat surface and vegetation characteristics (Belyea & Malmer, 2004; Strack & Waddington, 

2007; Limpens et al., 2008; Strack, 2008; Parish et al., 2008; Farmer et al., 2011; McCarter & 

Price, 2012; FAO, 2014; Comas et al., 2014; Cresto Aleina et al., 2015). Peat structure is the main 

factor directing water-table position, and is largely controlled by the intrinsic decomposition rates 

of surface vegetation, which determine resultant soil porosity (Hogg, 1993; Nungesser, 2003; 

Belyea & Malmer, 2004; Strack & Waddington, 2007; Strack, 2008; FAO, 2014; Comas et al., 

2014). Changes in soil porosity cause preferential hydrological flow patterns, ultimately creating 

spatial variability of water table depths across the peatland, and subsequently altering CH4 

generation and emission rates (Belyea & Malmer, 2004; Parish et al., 2008; Comas et al., 2014). 

Vegetation may also directly influence flux, as is the case of aerenchymous plants (ie. sedges) 
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which creates a direct link between the atmosphere and saturated CH4 producing soil layers via 

specialized aerated roots (Couwenberg et al., 2011; Kalacska et al., 2013).  

Peatland microtopography describes spatial variations in environmental conditions 

(temperature, surface moisture, vegetation, and nutrient availability) which can indirectly describe 

variability in CH4 gas generation and release (Cresto Aleina et al., 2015). Therefore, mapping 

peatland microtopography is anticipated to be a key step towards understanding, and predicting, 

small-scale heterogeneities in peatland CH4 emission rates.  

 
1.2.1.3 Peatland Response to Disturbances: Seismic Lines. 

Seismic lines have been used for oil and gas resource exploration by the petroleum industry 

since the 1950’s. Initially, construction of these features involved completely clearing a low-

density network of lines across the area of interest to substrate via bulldozer, with approximate 

widths of 8m or greater (Lee & Boutin, 2006; BC OGC, 2016). After the early 2000’s, and with 

the introduction of 3D seismic practices, line design transitioned to favour “low-impact” seismic 

(LIS) construction methods via hand clearing or mulching lines with 1 to 4m widths (Lee & Boutin, 

2006; Schneider & Dyer, 2006; BC OGC, 2016). However, LIS are constructed in high-density 

grids, with intervals on the scale of mere tens of meters, and as a result have been linked to wide-

spread ecosystem fragmentation among other impacts (Schneider & Dyer, 2006; BC OGC, 2016; 

Pattison et al., 2016). Furthermore, a clear definition of what qualifies as a “low-impact” line has 

not been established in land-use regulations (BC OGC, 2016). The term currently applies to lines 

of varying clearing widths, orientations, and construction seasons, which is misleading as changes 

in these factors have been strongly linked to the likelihood of successful revegetation and habitat 
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restoration (Schneider & Dyer, 2006; van Rensen et al., 2015; BC OGC, 2016; Pattison et al., 

2016). An example of a LIS transecting a boreal bog is provided in Figure 1.3. 

 

Figure 1.3: A low-impact seismic line traversing a boreal bog ecosystem in northern Alberta. 
This line was constructed in the late 2000s and though ground vegetation is apparent, few trees 
have reestablished. It is difficult to observe microtopography due to the presence of Labrador 
Tea. Image was provided by project partners. 

 
Construction of these linear features is linked with persistent changes in soil temperature, 

light levels, and increased soil compaction: all of which are known to influence natural recovery 

rates and successional trajectories (van Rensen et. al., 2015). The complete removal of micro-

topography during early line construction is also associated with permanent changes in vegetation 

composition and altered local hydrological regimes (van Rensen et. al., 2015). Given the 

previously described linkages between CH4 generation, water table position, and vegetation 

community, it is reasonable to expect these linear features will have an impact on peatland CH4 

emissions. Microform removal or compression and soil compaction is likely to cause decreased 
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ground elevation and increase overall water table position along seismic lines. Therefore, a strong 

case can be made for anticipating increased rates of CH4 emission along seismic lines relative to 

surrounding undisturbed peatland. 

Numerous studies have indicated that conventional seismic lines (those constructed from 

early 1950’s – 2000’s) are unlikely to recover to pre-disturbance conditions without active 

restoration efforts, particularly those which traverse lowland (peatland) areas conditions (Lee & 

Boutin, 2006; Schneider & Dyer, 2006; BC OGC, 2016). These lines often exist in a stalled 

successional state, or follow an alternative successive path to an ecosystem that is inconsistent 

with surroundings. In some examples, simple rewetting of peat soils is considered active 

restoration (Chimner et al., 2016), though a full peatland-restoration process has been developed 

in Canada by Quinty and Rochefort (2003). Even in cases where active restoration has occurred, 

predictive regression models suggest that 10 to 30 years may be required for comparable peatland 

microtopographic features to redevelop (Pouliot et al., 2011). While active restoration certainly 

does not guarantee restoration success (reported 40% occurrence of undesirable successional 

trajectory at 53 monitored bogs of eastern Canada), negligible (<1%) colonization of Sphagnum 

moss species has been reported in areas where active restoration was not pursued (Rochefort, 2000; 

Gonzalez & Rochefort, 2014). This suggests active restoration is a beneficial practice which 

increases chances of success. 

Estimates of total seismic-line disturbances within the western Canadian Boreal region 

range from 300,000 km to 1.7 million km, indicating these features represent wide-reaching, long-

term disruptions to the peatland ecosystems they intersect (Brandt, et. al., 2013; Pasher, Seed & 

Duffe, 2013). However, the majority of seismic-line research has focused on assessing the impacts 
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of early, “conventional” lines rather than LIS lines, due to the ability to easily identify larger lines 

with remote sensing (ie. Pasher, Seed & Duffe, 2013), and the ability to use these older lines to 

understand long-term ecosystem impacts (ie. van Rensen et al., 2015). As previously stated, LIS 

lines are likely to have extensive impacts due to their high-density construction, yet more research 

must be conducted to determine exactly how these lines are affecting ecosystems they intersect.  

 
1.3 The Role of Remote Sensing in Modelling Peatland Ecosystems 

There are currently three major platforms in remote sensing: satellite, airborne, and terrestrial. 

With any given platform, active sensors and passive sensors may be used to collect data. Satellite-

based platforms will not be discussed in great detail, although it is important to note that although 

satellite imagery is improving, imagery at high enough spatial resolutions to map small-scale 

peatland surface features, such as microtopography, is not currently available to the scientific 

community (Lehmann et al., 2016). Active sensors include laser altimetry, radio detection and 

ranging (RADAR), and light detection and ranging (LiDAR), which work by actively emitting 

electromagnetic radiation pulses and receiving returns to map ground targets (Lefsky et al., 2002). 

Passive sensors, alternatively, refer to systems relying upon reflected or emitted radiation, using 

spectrometers or similar sensors to passively collect radiance data (EisenbeiS, 2009). Unlike 

ground surveys, aerial platforms require knowledge of external parameters (positional 

information) to be captured simultaneously with each data point in order to reduce dataset errors 

(Lefsky et al., 2002; Lejot et al., 2007). This positional information may be captured by onboard 

equipment, including GPS systems to locate the platform, and inertial navigation systems (INS) to 

determine attitude (roll, pitch and yaw) of the sensor (Lefsky et al., 2002; Lucieer et al., 2014). 

Alternatively, this information  may be estimated from Structure from Motion (SfM) software used 
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in data processing. To counteract inaccuracies associated with unknown or poorly defined external 

parameters, ground control points (GCPs) may be used during image acquisition (Lejot et. al., 

2007). GCPs are target points of known location and elevation (x,y,z collected by survey grade 

terrestrial GPS system) which are visible in the acquired aerial imagery (Lejot et. al., 2007). These 

GCPs may be used to (i) increase the accuracy of digital elevation models (DEM) and orthophotos 

generated from the aerial imagery when GPS and INS systems cannot be used, (ii) georeference 

aerial survey products to determine global location of the imaged site, and (iii) to assess the overall 

accuracy of the DEM and orthophotos through model validation (Lejot et. al., 2007; Turner et. al., 

2012; Lucieer et. al., 2014). Similarly, knowledge of internal parameters (sensor specifications) in 

addition to these external parameters allow for data adjustments to determine true point locations 

more accurately (Lefsky et al., 2002; Lejot et al., 2007).   

Aerial imagery may be collected by manned or unmanned (ie. UAVs) systems. UAVs, are 

remotely controlled or autonomous fixed-wing or multi‐rotor drones capable of carrying a variety 

of sensors, including LiDAR and high-resolution digital cameras (Knoth et. al., 2013). Using the 

basic principles of photogrammetry (measuring geometry from photos), UAV flight plans allow 

for certain percentages of lateral and forward overlap across the study site (Lehmann et. al., 2016). 

Photographs must be assessed for quality to ensure blurred images or those with undesirable 

exposure conditions are removed prior to processing (Lehmann et. al., 2016). These overlapping 

photos can then be processed in stereoscopic pairings using commercial software packages such 

as Agisoft PhotoScan™, which utilize Structure from Motion (SfM) algorithms (or similar) to 

produce orthophotos and dense point clouds containing x,y,z information for each identified point, 

with corresponding global locations when georeferenced. Additional processing of the point cloud 
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can produce digital surface models (DSM: elevation models which include vegetation cover), 

digital terrain models (DTM: elevation models which exclude vegetation), canopy height models 

(CHM: surfaces produced by subtracting DTMs from DSMs), and orthophotos (planimetric 

images with relief distortion removed) (Lucieer et. al., 2014; Roosevelt, 2014). These products 

may be used alone or in combination to generate classified maps and other high-order information 

products (Lehmann, 2016). 

The major strength of UAVs when compared with alternative remote-sensing systems is 

the ability to collect data at nearly unlimited spatial and temporal resolutions, as well as the 

capability to investigate potentially hazardous areas, such as active volcanoes or landslides, with 

reduced risk to pilots (Eisenbeiß, 2009; Lechner et. al., 2012). Additionally, multiple cost‐benefit 

analyses comparing UAV surveys with alternative aerial surveys and ground surveys have proven 

UAVs to be comparable, if not economically superior (Knoth et. al., 2013; Roosevelt, 2014). For 

example, Roosevelt (2014) compared UAV photogrammetry (UAVP) data with RTK GNSS data 

of multiple archaeological sites in Turkey. The conclusions of this research indicated little 

difference in accuracy between the two datasets, with nearly all attributed to surface conditions 

(particularly vegetation) at the time of the UAVP survey (Roosevelt, 2014). However, vegetation 

and macrotopographic relief were also noted as impediments to ground survey accuracies 

(Roosevelt, 2014). Lucieer et. al. (2014) used UAVs to map the microtopography of Antarctic 

moss beds, reporting a geometric accuracy of 4cm for the produced orthophoto and DSM, and 

concluded that these high-spatial-resolution products were excellent for investigating 

microtopographic features and environmental relationships.   
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While the majority of current UAV instruments are passive sensors that are therefore 

unable to penetrate canopies to map ground surface in densely vegetated areas, comparisons of 

UAV and LiDAR topographic products indicates reasonably similar accuracies in open areas 

(Lefsky et. al., 2002; Mesas‐Carrascosa et. al., 2014). Additionally, point clouds produced from 

LiDAR instruments mounted on piloted aircraft tend to have low densities (<5pts/m2) compared 

to photogrammetric point clouds acquired from a UAV (100’s of pts/m2) (Sturm & Triggs, 1996; 

Pirotti & Tarolli, 2010). In this respect, UAV systems are more likely to capture minute differences 

in peatland microtopography (Knoth et. al., 2013). Furthermore, LiDAR data is usually more 

costly to acquire, limiting broad scale or repeated acquisitions (Knoth et. al., 2013).  

Some limitations or potential concerns with UAV data for environmental monitoring 

purposes include: flight influences on image resolution (determined by altitude and focal length of 

sensor lens), reliance on good meteorological conditions for flights and high image quality, and 

reduced flight times resulting from battery life and payload restrictions (Lejot et. al., 2007; Fritz, 

Kattenborn & Koch, 2013; Chisholm et. al., 2013). In particular, distortion resulting from small 

focal lengths of digital cameras (ie. 35mm) operating close to the ground may be much higher in 

UAV data (potentially >5 pixels) when compared to traditional photogrammetric systems 

(airplanes or helicopter platforms) which contain larger focal lengths operating further away from 

the ground (Lejot et. al., 2007; Eisenbeiß, 2009).  

 
1.3.1 Extracting Microtopographic Data. 

Previous researchers have distinguished peatland hummocks and hollows from each other 

in terrestrial or aerial surveys through comparative assessments of topographic features, such as 

relative elevation and slope, as well as vegetation community characteristics and depth to water 
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table (Bubier et al., 1993; Eppinga et al., 2009; Hartley et al., 2015; Lehmann et al., 2016). 

Microform classification thresholds appears to depend on site‐specific surface morphology, and 

researcher subjectivity. For example one study conducted within an eastern‐Canadian bog 

identified hummocks as areas ≥20cm above the maximum water table, while other research has 

identified hummocks as features rising 20‐50cm above surrounding hollows or the lowest reported 

elevation within a surveyed transect (Hogg, 1993; Bubier et al., 1993; Pouliot et al., 2011). Thus, 

in many cases applying elevation thresholds appears to be a simple, yet effective method for 

classifying (extracting) microtopography from survey data. 

 
1.3.2 Estimating Methane Emission. 

A variety of peatland models currently exist and are used to represent ecosystem-level 

interactions and estimate GHG emission (Wu et. al., 2010; Cresto Aleina et. al., 2015; Shi et. al., 

2015). Generally, these models combine environmental information (area hydrology, climate, 

vegetation etc.) with point-measured gas flux, and leverage spatial data (ie. ground survey, aerial 

survey) to upscale flux estimates to a larger study area. One method of upscaling local flux data to 

a larger area is described by Wu et al. (2010) as parameter upscaling. This process involves 

weighting variable values by the fractional area coverage of each identified unit (Wu et. al., 2010). 

When considering peatland microtopography, the variable would be CH4 emission, and individual 

units would refer to identified microforms (hummocks, hollows, etc.). Therefore parameter up-

scaling would involve weighting CH4 flux values reported for each microform by the areal 

coverage of that microform. This method of upscaling has been found to be more computationally 

efficient than alternate methods, though it is not anticipated to capture as much variability of the 

modeled variable (Wu et. al., 2010). In order to properly upscale CH4 fluxes to the ecosystem from 
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microtopographic data, flux data must be collected for each identified microform class, or 

reasonable assumptions (such as conservative estimates) should be made in place of missing data 

(Lehmann et. al., 2016).  

Shi et. al. (2015) included microtopographic data into a computer model designed to predict 

peatland hydrological responses to altered climate variables (ie. increased air temperatures). This 

model utilized parameter upscaling of modelled peatland microtopography (assuming 75% 

hummock land cover and 25% hollow land cover as determined by field observations) to estimate 

responses in vegetation distribution and subsurface biogeochemical processes (Shi et. al., 2015). 

The model was compared to half‐hour field measurements of water table fluctuations over 3 years, 

and showed strong agreement between modelled data and field values (Shi et. al., 2015). 

Discussion of these results suggest that inclusion of microtopographic data is essential in 

accurately representing ecosystem processes (Shi et. al., 2015). Another study involved the 

development of a new modelling system, named the hummock‐hollow (HH) model, based 

primarily on peatland microtopography to simulate upscaling of CH4 hotspots and assess 

underestimation of CH4 in boreal peatlands (Cresto Aleina et. al., 2015). In this case, 

microtopographic information was based on a ground surveys (via theolodite) of the peatland study 

site, with hummocks distinguished as areas reported higher than a local reference point by 20cm 

(Cresto Aleina et. al., 2015). The HH model was developed using historical data at a 1m x 1m grid 

(microform level) before upscaling to a 1km x 1km grid (peatland ecosystem level) (Cresto Aleina 

et. al., 2015). It was then used to predict peatland CH4 response to air temperature increases 

predicted by climate-change models (Cresto Aleina et. al., 2015). Results indicated that the 

inclusion of microtopographic data into the GHG model improved output, compared to traditional 
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modelling approaches (Cresto Aleina et. al., 2015). This study called for improved peatland 

microtopographic-mapping techniques to allow for more accurate simulations of surface patterns, 

hydrology, and CH4 hotspots (Cresto Aleina et. al., 2015). 

 
1.4 Statement of the Problem 

Approximately 16% of Alberta is covered by Boreal peatlands, many of which have been 

extensively disturbed by a dense network of seismic lines used to delineate valuable underlying 

petroleum resources (Schneider & Dyer, 2006; Webster et al., 2015). Since activities which disrupt 

peatland environmental conditions may trigger carbon release, the widespread disturbance of 

Alberta’s Boreal peatlands is likely to have stimulated CH4 emissions. However, this theory has 

yet to be tested, since the impact of seismic lines on Boreal peatland surface conditions and CH4 

release has never been quantified. Microtopography and depth-to-water, controlling factors on 

peatland CH4 emission, can vary significantly over short distances, which makes them difficult to 

monitor from low-resolution imagery. However, monitoring these features via UAV platforms 

fitted with passive sensors is challenged by the capability of western Boreal peatlands to sustain 

ground-obscuring tree growth. This thesis strives to address the knowledge gaps associated with 

modeling seismic line impacts on Albertan Boreal peatlands.  

 
1.5 Research Objectives  

Two main objectives are addressed in this research: 

1. To assess the capacity of UAV photogrammetry for modelling microtopography in 

complex peatland systems within Alberta by: 
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a. Assessing the accuracy of modelling peatland microtopography using UAV 

photogrammetry, and 

b. Developing a method for characterizing (classifying) peatland surface morphology 

using UAV imagery 

2. To quantify the impact of seismic lines on physical environmental parameters 

(microtopography and depth-to-water), and CH4 emission, in a typical treed bog of 

northern Alberta 

 
1.6 Organization of the Thesis 

Efforts to satisfy these research objectives are summarized in two independent research articles, 

which comprise the main body of the thesis. Chapter 2 explains the suitability for UAV platforms 

in characterizing terrain of a complex peatland ecosystem of western Canada (Objective 1a). It 

addresses recommendations from numerous previous research studies calling for improved 

methods of estimating peatland GHG emission, through refined spatial data, by determining 

whether UAVs are up to this task in western Canada. Chapter 3 describes a methodology for 

classifying peatland microtopography (Objective 1b) and estimates CH4 emission from the treed 

bog using the microtopographic surface and a complimentary depth-to-water surface (Objective 

2). This chapter also presents the first-known quantification of physical and GHG-related impacts 

of peatland disturbance by seismic lines. Chapter 4 summarizes conclusions drawn from this 

research, outlines main contributions, and details potential opportunities for future research. 
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Chapter Two: Assessing the Value of UAV Photogrammetry for Characterizing Terrain in 

Complex Peatlands 

2.1 Abstract 

Microtopographic variability in peatlands has a strong influence on greenhouse gas fluxes, but we 

lack the ability to characterize terrain in these environments efficiently over large areas. To address 

this, we assessed the capacity of photogrammetric data acquired from an unmanned aerial vehicle 

(UAV or drone) to reproduce ground elevations measured in the field. In particular, we set out to 

evaluate the role of (i) vegetation/surface complexity and (ii) supplementary LiDAR data on 

results. We compared remote-sensing observations to reference measurements acquired with 

survey grade GPS equipment at 678 sample points, distributed across a 61 hectare treed bog in 

northwestern Alberta, Canada. UAV photogrammetric data were found to capture elevation with 

accuracies, by root mean squares error, ranging from 14–42 cm, depending on the state of 

vegetation/surface complexity. We judge the technology to perform well under all but the most-

complex conditions, where ground visibility is hindered by thick vegetation. Supplementary 

LiDAR data did not improve results significantly, nor did it perform well as a stand-alone 

technology at the low densities typically available to researchers. 

 
2.2 Introduction 

Fine-scale variability in elevation, commonly referred to as microtopography, is an important 

factor in the distribution of greenhouse gas (GHG) flux across peatland ecosystems (Lucieer et al., 

2010; Couwenberg et al., 2011; Macrae et al., 2013; Comas et al., 2014; FAO, 2014; Cresto Aleina 

et al., 2015; Acharya et al., 2015). Consequently, including microtopographic information in 

carbon-balance models is often recommended as a means of improving model accuracies (Strack 
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et al., 2006; Farmer et al., 2011; Cresto Aleina et al., 2015; Shi et al., 2015; Lehmann et al., 2016). 

Most commonly, microtopographic data are acquired via terrestrial surveys using real-time 

kinematic global navigation satellite system (RTK GNSS) equipment, which are capable of 

centimeter accuracies (Pouliot, Rochefort & Karofeld, 2011; Roosevelt, 2014). However, 

terrestrial surveys are limited by high costs and personnel requirements, and do not scale well over 

large areas (Roosevelt, 2014).  

Recently, researchers have used photogrammetric data from unmanned aerial vehicles 

(UAVs) to acquire detailed microtopographic data in a variety of terrestrial settings, suggesting 

that the technology might provide an attractive alternative to traditional ground surveys in 

peatlands. Using standard consumer-grade cameras, UAVs can produce high-density point clouds 

(100 s of points per m2) and ultra-high resolution orthomosaics with modern photogrammetry 

principles and structure from motion (SfM) computer-vision software (Sturm & Trigs, 1996). 

Roosevelt et al. (2014) found UAV photogrammetry to be one order of magnitude more labor-

efficient and at least two orders of magnitude more detailed (in terms of data density) than RTK 

GNSS surveys for microtopographic archaeology surveys in western Turkey. Working in gently 

sloping, sparsely vegetated hills interspersed with olive orchards, the authors reported vertical root 

mean squares error (RMSE) values of 21 cm compared to ground control points (GCPs). Lucieer 

et al. (2014) reported even better RMSE accuracies of 4 cm in microtopographic surveys of East 

Antarctic moss beds with UAV photogrammetry. Using an alternative multispectral approach, 

Lehmann et al. (2016) classified vegetation species and microforms with high accuracy (>80%) 

using UAV-derived color infrared (CIR) imagery of a South Patagonian peatland. While this 
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research did not make use of photogrammetric elevation data, the authors suggested that doing so 

would have increased classification accuracies even further (Lehmann et al., 2016).  

Building on these promising early studies, there is a need to evaluate the performance of 

UAV photogrammetry in other, more complex environments. The peatlands of the boreal zone 

contain globally significant carbon stocks, and are an essential target for climate-change studies 

(Strack, 2008, Munir et al., 2014). However, terrain modeling in these environments is expected 

to be more challenging for UAV photogrammetry, given the complexity of the surfaces and the 

presence of vascular vegetation, both of which can negatively affect the performance of SfM 

workflows. For example, Javernick, Brasington & Caruso (2014) assessed photogrammetric point 

clouds from UAVs for modelling the topography of a shallow braided river in New Zealand, and 

found vegetation cover to negatively affect results. Vertical accuracies fell from 17 cm (RMSE) in 

bare areas to 78 cm in areas of vegetation, due to the inconsistent ability of passive photography 

to penetrate the vegetation canopy (Javernick, Brasington & Caruso, 2014). Similarly, elevated 

wind speeds have been shown to decrease UAV data quality in vegetated areas due to movement 

of the canopy surface (increased photo blurriness), and interference with UAV positioning and 

orientation during image capture (Jensen & Mathews, 2016; Zainuddin et al., 2016). In some cases, 

this effect can be severe. For example, Zainuddin et al. (2016) found excessive tree leaf movement 

due to strong winds during UAV data acquisition caused ten trees to be completely missed in the 

produced point cloud, and increased uncertainty in ground surface elevations around modeled 

trees. This ultimately resulted in a poor quality, and non-useful 3D model for estimating canopy 

heights (69.6 cm RMSE; Zainuddin et al., 2016).  
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Additional challenges associated with elevation changes, presence of standing water and 

image-texture homogeneity have also been noted in the literature. For example, Mancini et al. 

(2013) compared UAV point clouds from passive photogrammetry to those derived from a 

terrestrial light detection and ranging (LiDAR) scanning system, an active (laser) technology, over 

sand dunes in Italy. The authors found photogrammetric point density to decrease in flat bare areas, 

due to the inability of the SfM feature-matching algorithm to reliably identify tie points. Areas of 

dense vegetation were excluded from this assessment, though sparse vegetation (15- to 20-cm 

patches) were included in the linearly interpolated DSM surfaces and reportedly influenced overall 

accuracy (11 cm RMSE; Mancini et al., 2013). Similar results have been reported in areas of 

standing water, where the surface is too homogenous to accurately locate tie points, or where 

variations in reflectance across the water surface cause SfM algorithms to incorrectly estimate 

point locations (Rosnell & Honkavaara, 2012; James & Robson, 2012).  

One potentially promising strategy involves combining passive photogrammetric data (high point 

density, but limited canopy penetrating abilities) with airborne LiDAR, which typically has lower 

densities but an enhanced capacity to penetrate vegetation. LiDAR has proven to be highly 

accurate in estimating ground surface elevations within bare, flat areas (Lefsky et al., 2002; Pirotti 

& Tarolli, 2010), though canopy interference and low point densities are likely to decrease 

estimated surface accuracies in more complex environments. However, these data have yet to be 

widely assessed in a peatlands context. 

The goal of this research is to assess the value of UAV photogrammetry for characterizing 

terrain in vegetated peatlands in the Canadian boreal forest. In this study, we worked in a treed-

bog ecosystem in North-West Alberta, Canada that displayed a wide range of complexity, from 
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relatively flat, open areas to a mixture of highly undulating and treed zones. Our objective was to 

assess the accuracy of photogrammetric point clouds for capturing terrain elevation under a variety 

of vegetation/surface-complexity conditions, paving the way for future work aimed at classifying 

peatland microtopographic landforms (hummocks and hollows). In addition, we also assessed the 

value of supplementary LiDAR data over the same gradient of complexity. To achieve these 

objectives, we created three-dimensional point clouds from three different remote sensing data 

sets: (i) UAV photogrammetry; (ii) LiDAR; and (iii) merged UAV photogrammetry + LiDAR. 

The accuracy of these data sets was assessed using terrestrial surveys conducted in the field. 

 
2.3 Materials and Methods  

2.3.1. Study Area. 

The study site is a 61-hectare section of treed bog located approximately 35 km northeast 

of Peace River, Alberta, Canada (Figure 2.1). The site is a mixture of open bog, mostly covered 

by mosses and lichens (e.g., Sphagnum mosses, big red stem moss (Pleurozium schreberi), stair 

step moss (Hylocomium splendens), fairy’s puke (lcmadophila ericetorum), and reindeer lichens 

(Cladina stellaris, C. rangiferina, C. mitis)), shrubby bog with dispersed to moderately dense 

shrubs (e.g., Labrador tea (Rhododendron groenlandicum) and Lignonberry (Vaccinium vitis-

idaea)), and moderately dense treed bog dominated by black spruce (Picea mariana). In the few 

marginal fen-like areas, tamarack (Larix laricina) and willow (Salix spp.) are present. Upland areas 

are dominated by mixed forest including balsam poplar (Populus balsamifera), trembling aspen 

(Populus tremuloides) and white spruce (Picea glauca). Black spruce, the dominant tree species 

in boreal bog ecosystems, do generally not produce large-diameter canopies. However, these trees 
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are dense enough in some portions of our study site to obscure the ground surface from passive 

sensors, as are shrubby vegetation cover types such as Labrador tea.  

 

Figure 2.1: Approximate site location in the province of Alberta (AB) with reference to nearby 
notable city centers (1a); estimated distribution of surface complexity classes across the study 
site (1b). An extensive network of linear disturbances transect the site. Areas between these 
features are assumed to be undisturbed and indicative of natural boreal treed bog conditions 
within the region. GCP installation locations, cluster sample and detailed transect points are 
shown (1b), and described in Section 2.3.2.1. 

 
Microforms (hummocks and hollows) are well established in undisturbed bog portions of 

the study area, and generally occur at scales between 30 and 100 cm. However, a network of linear 

disturbances, including seismic lines, a pipeline right-of-way (ROW), and a roadway, also transect 

the site.  



 

  

39 

 

For the purpose of this research, we stratified the study area into four classes of surface 

complexity, based upon visual observations of the site conditions: tree cover, anticipated surface 

irregularity (roughness), and visual homogeneity. The four classes were defined as: 0. Bare Areas; 

1. Low Complexity; 2. Moderate Complexity; and 3. High Complexity. An example of each class 

is provided in Figure 2.2. Class 0 (Figure 2.2a) exclusively describes the newly constructed 

roadway and large south pond; Class 1 (Figure 2.2b) represents linear disturbances within the bog; 

Class 2 (Figure 2.2c) includes sparsely treed, undisturbed portions of the bog; and Class 3 (Figure 

2.2d) represents more densely treed areas of undisturbed bog and upland zones.  

 

Figure 2.2: Examples of each surface complexity class found within the study site. Data 
displayed is captured from the orthophoto. The example of Class 0 (2.2a) is taken from the new 
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clay road bisecting the study area, Class 1 (2.2b) is taken from a pipeline ROW, Class 2 (2.2c) is 
from undisturbed portions of the bog, and Class 3 (2.2d) is from densely treed portion of bog. 

 
The spatial distribution of surface complexity classes across the study area is displayed in 

Figure 2.1b. The approximate areal coverage of each class is estimated as following: Class 0—

5%; Class 1—43%; Class 2—36%; and Class 3—16%. Although, Class 0 areas do not occur in 

naturally peatland ecosystems, including these points in the assessment serves as a baseline for 

investigating the effects of surface complexity on point cloud accuracy.  

 
2.3.2. Data Sets. 

Two types of data were acquired for this study: terrestrial surveys and remote sensing 

observations. Descriptions of the assembly and handling of these data are provided in the following 

sections.  

 
2.3.2.1. Terrestrial Surveys. 

Terrestrial ground surveys were used to assess the capacity of remote sensing to 

characterize terrain within the study area. A total of 678 points were acquired for this purpose, 

including 474 from cluster sampling and 204 from systematic transects. Cluster samples were 

acquired around 48 locations distributed randomly across the study area (Figure 2.1b). Cluster 

centers were marked with visible targets that served as ground-control point (GCP) locations for 

the UAV flights (described below), and so were positioned in locations visible to the sky. As a 

result, field crews occasionally moved cluster centers up to several meters from their randomly 

assigned locations. Around each cluster center, field crews surveyed between 6 and 12 points on 
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representative high points (hummocks) and low points (hollows) of terrain, regardless of visibility 

to the sky.  

Additional terrestrial survey points were acquired along three ~10 m transects: two located 

near the access road and a third in an undisturbed location away from the road (Figure 2.1b). On 

these transects, ground elevations were recorded systematically at 10-cm intervals. Visibility to 

the sky was not a factor in selecting or surveying these transects. All terrestrial surveys were 

conducted with a Trimble R4 RTK GNSS system with a base station set up on a nearby survey 

monument. Average horizontal (x, y) and vertical (z) errors for terrestrial surveys was 0.87 cm and 

1.47 cm, respectively.  

 
2.3.2.2. Remote Sensing Observations. 

2.3.2.2a UAV Photogrammetry. 

Due to persistent full sun conditions, and third-party UAV operator time limitations which 

prevented early morning or late evening flights, UAV data were collected in two flights on July 

13th and 14th, 2016. The first flight was completed in the late afternoon (approximately between 

5:00 and 7:00 p.m.) on July 13th and the second in the mid-morning (approximately between 9:00 

and 11:00 a.m.) of July 14th. The purpose of conducting two flights was to reduce impacts of deep 

shadows by collecting complimentary site data with opposing shadow angles, and subsequently 

using both datasets in point cloud production. Flight data was collected using an Aeryon Scout 

multirotor platform carrying an HDZoom30 20-megapixel optical camera with global shutter, and 

approximately 25 min flight duration per battery (3 batteries required to complete flight plan). 

Moderate average wind speeds were reported for the duration of flight operations (4 m/s on July 

13th and 2 m/s on July 14th), and were determined to be acceptable for flight operations as per 
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UAV specifications reported by UAV Geomatics (wind limit of 13.9 m/s) and previous research 

findings (UAV Geomatics, 2011; Rosnell & Honkavaara, 2012). All flights were conducted at 110 

m altitude, with a ground-sample distance of 2 cm or less. Parallel flight lines were configured 

across the site to generate 80% endlap and 60% sidelap amongst individual photos, and photos 

were obtained in movement (4 m/s flight speed) to minimize the number of required battery 

replacements.  

Ground control was provided by ten permanent GCPs distributed systematically across the 

study area, and 48 additional GCPs distributed randomly (Figure 2.1b). As described in Section 

2.3.2.1, these 48 additional GCPs also served as the cluster-center locations for terrestrial surveys. 

All GCPs were surveyed with the same RTK GNSS system described previously. 

Raw UAV photographs were processed using Agisoft PhotoScan (Agisoft PhotoScan 

Professional Edition, 2016) to generate a dense point cloud (DPC) and digital orthophotography. 

In the first step, photo quality was assessed with the Agisoft Photoscan photo-quality assessment 

tool to determine whether low quality photos (<0.5) existed. From this assessment, all photos were 

determined to exceed this threshold (reporting > 0.66) and were therefore included in the dataset. 

Photos were then aligned using camera positions estimated by the onboard GPS during flight, and 

adjusted with the 10 permanent GCPs in the photos. The sparse point cloud generated through this 

alignment process was then optimized, with high-error tie points removed, prior to generating a 

dense point cloud and orthophoto mosaic.  

Ground points (i.e., not vegetation) were extracted from the UAV DPC using a 

combination of LAStools (Isenburg, 2016) and Cloud Compare (CloudCompare, 2016) software. 

Cloud Compare is an open-source software package designed specifically for point-cloud 



 

  

43 

 

processing, and contains significant outlier-removal and noise-filtering tools which we found to 

work well with photogrammetric data. We used LAStools to perform general tasks such as initial 

noise filtering, classifying, and merging datasets. This workflow is summarized in Figure 2.3. 

The classified ground DPC (gDPC) was edited manually to remove outliers that had been 

missed in the automatic filtering process. Point density of the resultant gDPC was calculated at 

84.68 pts/m2, although coverage was not uniform across the site and data gaps existed in areas of 

dense canopy cover. Average point spacing was 13 cm, with a total of 36,880,406 points in the 

cloud.  
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Figure 2.3: Photogrammetric and point-cloud management software workflow illustrating the 
process of using UAV flight data to generate secondary (DPC and orthomosaic) and tertiary 
products (ground dense point cloud (gDPC)) used in this research.  
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2.3.2.2b LiDAR. 

LiDAR for the area was commissioned by Shell Canada and collected, processed, and 

calibrated by Airborne Imaging in May of 2013. This data was provided to the researchers in LAS 

format for use in this project. Raw point density of this dataset was reported as 4 pts/m2. While we 

acknowledge the temporal disconnect between the LiDAR data (2013) and those of the UAV and 

terrestrial surveys (2016), we assume that the terrain elevations, which are the focus of this study, 

remained constant across this time period.  

LAStools was used to classify ground points (ASPRS Class 02) from the raw point cloud 

(overall classification accuracy 96%), and remove noise from LiDAR data. The point density of 

the processed data was 2.88 pts/m2, with approximate point spacing of 0.59 m and a total of 

1,731,506 points.  

 
2.3.2.2c Merged UAV Photogrammetry + LiDAR. 

A combined UAV photogrammetry + LiDAR dataset was generated by merging the UAV 

gDPC with the ground points classified from LiDAR using LASmerge. While LiDAR clearly had 

lower overall point densities than the UAV dataset, it was found to have more consistent data 

coverage across the site, including densely vegetated areas which corresponded with (sometimes 

large) gaps in the UAV data. Therefore, the purpose of generating this combined dataset was to 

determine whether point cloud performance could be improved by using the LiDAR to fill these 

gaps.  
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2.3.3. Accuracy Assessments.  

The capacity of the three remote sensing data sets—(i) UAV photogrammetry; (ii) LiDAR; 

and (iii) merged UAV photogrammetry + LiDAR—to capture terrain across the study area was 

asssessed using all appropriate terrestrial-survey points, stratified across the four classes of 

complexity described in Section 2.3.2.2.a. 

 
2.3.3.1. UAV Photogrammetry Dataset Performance. 

A total of 19 GCPs were used to assess the overall accuracy of the dense photogrammetry 

point cloud (pre-gDPC generation). GCP location and elevation values estimated by PhotoScan 

were compared with those collected by RTK to determine overall location accuracy (x, y, and z). 

The comparison of RTK vs reported PhotoScan GCP locations (x, y, z) returned RMSE values of 

4 cm, 8 cm, and 13 cm, respectively. These high accuracies were corroborated by mean offset (8 

cm) measurements made from the orthophoto.  

A rigorous evaluation of terrain accuracy (gDCP) was assessed in two ways; first through 

comparision of the dataset with all 678 RTK control points, and second by comparing the dataset 

with with control points stratified by the four classes of surface complexity. Accuracy was 

determined as the difference between RTK survey point elevations and the nearest point value in 

the gDCP dataset (gDCP(z) − RTK(z)). 

 
2.3.3.2. Supplemented LiDAR Performance. 

The performance of the LiDAR and supplemented UAV photogrammetry+LiDAR datasets 

were assessed in the same manner as that described for the UAV photogrammetry data (Section 

2.3.3.1 above). Firstly, all suitable RTK points (629 total) were used to assess the overall accuracy, 
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followed by a second assessment of points classified by surface complexity. However, no points 

were identified in Class 0, since the LiDAR data pre-dated road construction and no alternative 

bare areas (Class 0) were available. Therefore, we only preformed stratified accuracy assessment 

for three classes of surface complexity: Low (1); Moderate (2); and High (3). 

LiDAR horizontal (x, y) accuracy and vertical (z) accuracy (on flat, hard surfaces) were 

reported by the acquisition company to be 30 cm and 10 cm, respectively. 

  
2.3.4. Statistical Analysis. 

Following the example of previous studies (Harwin & Lucieer, 2012; Turner, Lucieer & 

Watson, 2012; Lucieer et al., 2014; Mercer & Westbrook, 2016), we measured the accuracy and 

precision of each dataset with root mean squares error (RMSE), average absolute error, mean error, 

median error, and median offset (the difference between dataset medians).  

Since the variance and sample sizes were unequal within the UAV photogrammetry dataset, a 

robust one-way analysis of variance (ANOVA) and Welch’s test were conducted in SPSS software 

to determine whether significant differences existed between classes of surface complexity (α = 

0.05). Following this, a Tamhane pairwise comparison was conducted to determine where 

significant differences existed. All results were corroborated by a non-parametric Kruskal-Wallis 

test.  

A two-way mixed model ANOVA test (α = 0.05) was conducted on the UAV 

Photogrammetry and UAV Photogrammetry + LiDAR datasets in SPSS software to determine 

whether performance was significantly different between classes and between datasets. Based 

upon these results, a pairwise comparison was not deemed necessary. A second two-way mixed-

model ANOVA test (α = 0.05) was conducted on all three datasets (UAV photogrammetry, 
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LiDAR, and UAV photogrammetry + LiDAR) to determine whether statistically significant 

differences existed between classes, and between datasets. A subsequent pairwise comparison with 

a Bonferroni adjustment was used to determine where specific significant differences occurred.  

 
2.4 Results  

Tables 1 and 2 summarize the results of the elevation accuracy assessments. Table 2 presents 

dataset performance across all suitable RTK points, while Table 2 shows elevation accuracies of 

points stratified by surface complexity. There was no statistically significant difference (F(1, 625) 

= 0.130, p = 0.718) between the overall (unstratified) results obtained by UAV photogrammetry 

(average absolute error 31 cm, mean error 27 cm, and RMSE 40 cm), and the ‘enhanced’ UAV 

photogrammetry + LiDAR dataset (average absolute error 30 cm, mean error 27 cm, and RMSE 

38 cm). However, LiDAR data alone (average absolute error 42 cm, mean error 41 cm, and RMSE 

84 cm) performed significantly worse overall (F(1, 625) = 6.041, p = 0.014). All three data sources 

displayed positive median offsets: 23 cm for UAV photogrammetry, 27 cm for UAV 

photogrammetry + LiDAR, and 47 cm for LiDAR alone. 

 
Table 2.1. Dataset Accuracies: Comparison of Dataset Elevations against all RTK Surveyed 
Point Elevations (678 UAV Photogrammetry dataset and 629 LiDAR and UAV 
photogrammetry + LiDAR datasets). 
 

Dataset 
Avg ABS z 
Error (cm) 

Mean z 
Error (cm) 

RMSE (cm) 
Median z 

Error (cm) 
Median z 

Offset (cm) 

UAV Photogrammetry 31 27 40 25 23 

LiDAR 42 41 84 25 47 

UAV Photogrammetry + 
LiDAR 

30 27 38 25 27 
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Table 2.2. Dataset Accuracies: Comparison of Dataset Elevations against RTK Point 
Elevations Classified by Surface Complexity. 
 

Class Dataset 
Avg ABS z 
Error (cm) 

Mean 
Error 

(cm) 

RMSE 
(cm) 

Median z 
Error (cm) 

Median z 
Offset (cm) 

Class 0 
UAV 14 −1 15 −8 −10 

(42 points) 

Class 1 
UAV 21 15 26 15 −10 
LiDAR 14 12 18 10 −1 

(53 points) UAV + LiDAR 20 14 25 14 −6 

Class 2 
UAV 23 21 28 20 15 
LiDAR 34 33 68 23 33 

(264 points) UAV + LiDAR 23 21 27 20 15 

Class 3 
UAV 42 37 51 35 47 
LiDAR 58 56 110 29 56 

(312 points) UAV + LiDAR 39 35 47 32 46 
 

This same relative pattern—no significant difference between UAV photogrammetry alone 

and UAV photogrammetry + LiDAR (F(2, 625) = 2.292, p = 0.102); significantly worse 

performance by LiDAR data alone (F(1, 625) = 6.041, p = 0.014) was also observed in the stratified 

results (Table 3), and we also observed a statistically significant class effect (F(2, 625) = 22.924, 

p < 0.001). Predictably, errors were found to increase with surface complexity, with the best results 

found in Class 0 (average absolute error 14 cm, mean error −1 cm, and RMSE 15 cm for UAV 

photogrammetry), and the worst found in Class 3 (average absolute error 42 cm, mean error 37 

cm, and RMSE 51 cm for UAV photogrammetry). 

Looking specifically at the UAV photogrammetry data, significant differences could be 

observed amongst surface-complexity classes (ANOVA: F(3, 674) = 36.969, p < 0.001, Welch: 

F(3, 134.225) = 53.185, p < 0.001). A post-hoc Tamhane pairwise comparison (α = 0.05) revealed 

that the performance of these data in Classes 0 and 3 were significantly different from other classes 
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(all p < 0.001), while Classes 1 and 2 performed statistically the same (p = 0.381). A non-

parametric Kruskal-Wallis test corroborated these findings.  

 
2.5 Discussion  

We found UAV photogrammetry to perform better than LiDAR in the task of characterizing terrain 

across our study site, suggesting that the superior point densities delivered by UAV 

photogrammetry are more important than the enhanced canopy penetrating abilities of LiDAR. 

While both technologies tended to over-estimate terrain elevation, we found photogrammetric 

point clouds to be better able to track microtopographic variability (Figure 2.4). ‘Enhancing’ 

photogrammetric datasets with LiDAR does not appear to be worth the increased technical and 

financial costs.  

 

Figure 2.4: A comparison of dataset performance along a detailed transect within an 
undisturbed portion of the study site (representing a mixture of Classes 2 and 3). Both UAV 
photogrammetry and LiDAR overestimate ‘true’ ground-surface elevation, represented in black, 
though UAV photogrammetry is better-able to capture microtopographic variability. The area in 
green indicates ground points that were fully covered by vegetation canopy. 

 
While the overall errors reported for UAV photogrammetry data (40 cm RMSE) are 

nominally worse than those reported by other researchers (21 cm from Roosevelt (2014); 4 cm 

from Lucieer et al. (2014)) we found significant variability amongst surface-complexity classes. 
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Areas of high complexity (Class 3) were found to perform significantly worse than other classes, 

whose accuracy statistics were more in line with previously published values (Class 0—14 cm; 

Class 1—21 cm; and Class 2—23 cm). The observation that UAV photogrammetry performed the 

same across the low and moderate categories of peatland complexity (Classes 1 and 2), suggests 

that this technology is suitable for characterizing terrain under all but the most-complex conditions. 

The errors we observed in Class 1 and Class 2 are generally below the scale of microforms (25 cm 

up to 1 m) across the site, and are therefore likely suitable for mapping microtopography. The fact 

that highly complex Class 3 areas were relatively rare in our study site—16% of the area as 

compared to 79% for Classes 1 and 2—lends even further confidence to the notion that UAV 

photogrammetry can be used to characterize topography in treed bogs such as the one assessed 

here.  

The reduced performance of UAV photogrammetry in highly complex (i.e., heavily treed) 

areas can be partially explained by the decrease in point density on these sites: 77.5 pts/m2 overall 

compared to 86.7 pts/m2, 81.3 pts.m2, and 91.6 pts/m2 for Classes 0, 1, and 2, respectively. There 

are many more ‘data holes’ in these areas as well (Figure 2.5), reflecting the inability of passive 

photography to reliably penetrate thick canopies (Javernick, Brasington & Caruso, 2014). We had 

thought that these difficult conditions would be assisted by supplementary LiDAR; this turned out 

not to be the case in our study site. Not only did UAV photogrammetry + LiDAR fail to perform 

significantly better than UAV photogrammetry alone in this class (47 cm RMSE vs. 51 cm), but 

LiDAR data on its own was the worst-performing dataset in Class 3 (58 cm RMSE). While LiDAR 

is capable of penetrating vegetation canopies to a certain degree, ground point collection is still 

influenced by vegetation cover (Lefsky et al., 2002; Hopkinson et al., 2005; Chasmer, Hopkinson 
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& Treitz, 2006), and the point density is far too low overall to accurately capture microtopographic 

variability (Figure 2.5).  

 

Figure 2.5: Comparison of vegetation influence on dataset point densities, modeling a seismic 
line and adjacent undisturbed peatland. Examples of each surface complexity class indicated as: 
① = Class 1 (low); ② = Class 2 (moderate); ③ = Class 3 (high). 

 
While UAV photogrammetry alone is capable of mapping most treed-bog terrain at 

acceptable levels of accuracy, its spatial coverage is limited: typically less than 100 ha for UAV 

platforms, which must fly within visible line of sight. While airborne LiDAR can cover larger 

areas, it is more expensive to fly, and typically not acquired at point densities sufficient for 

mapping peatland microtopography. We did not test high-density LiDAR, but our observations 

suggest that densities would have to exceed 30–50 pts/m2 in order to be effective at this task. 
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Potential Sources of Error. 

All data used in this research are subject to a variety of error sources during collection, 

processing, and analysis. Firstly, the RTK GNSS system is subject to errors introduced by satellite 

and radio link connectivity, which is reliant upon external factors such as canopy cover (Roosevelt, 

2014), and differences in measurement techniques between field personnel. In order to mitigate 

these errors, survey summaries were reviewed to ensure RTK points used in the comparisons were 

reported at accuracies reasonable for microform scale (<20 cm). Additionally, we maintained 

consistency in field personnel to reduce errors in ground measurements. 

UAV photogrammetry data may be compromised by external factors such as flight and 

weather conditions. To offset these sources of error, multiple flights were conducted to address 

deep shadows resulting from full sun conditions, as described in Section 2.3.2.2.a. Additionally, 

flights were completed in low to moderate wind (<4 m/s) and dry conditions (little to no standing 

water and/or moisture present at surface in vegetated areas) to reduce errors associated with these 

factors. Standing water was observed along the newly constructed roadway, which may have 

increased errors associated with Class 0 areas. However, as Class 0 areas do not occur naturally 

within peatland ecosystems, correcting for this source of error was not deemed a priority. Increased 

overlap may have improved overall model accuracies in areas of highly complex terrain, and 

should be considered in similar future studies. The distribution and number of GCPs was 

determined to be adequate for the study area, and not a major anticipated source of error, as ten 

GCPs per km2 is a well-established standard in aerial photogrammetry (Krauss, 1997; McGlone, 

Mikhail & Bethel, 2004). 
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2.6 Conclusions  

The primary objective of this research was to evaluate the capacity of UAV photogrammetry to 

characterize terrain elevation in a boreal treed bog across four categories of vegetation/surface 

complexity: bare, low, medium, and high. Photogrammetric data were found to perform well under 

all but the worst (heavily treed) conditions, with RMSE accuracies ranging from 14–23 cm. Based 

on this assessment, we suggest that UAV photogrammetric technology provides a reasonable 

foundation for supplementing or even replacing traditional RTK GNSS ground surveys for 

characterizing peatland terrain in low- and moderately complex conditions. While positive 

elevation offsets can be expected to occur, the high point density provided by this technology is 

generally capable of tracking microtopographic terrain undulations. This capacity can be expected 

to diminish (we documented 42 cm RMSE) in areas of high surface complexity due to the inability 

of passive photography to reliably penetrate thick vegetation canopies. As a result, site conditions 

should be considered carefully prior to adopting this technology in peatland-terrain-mapping 

applications, and researchers should determine whether or not the anticipated accuracies will meet 

the intended purpose.  

We also assessed the value of supplementary LiDAR over the same gradient of complexity, 

anticipating that the enhanced canopy penetrating capacity of this technology might work well 

with the enhanced point densities provided by photogrammetry. However, we found no support 

for this concept, suggesting the type of low-density (ours was 2.88 pts/m2) LiDAR data typically 

available to researchers is not worth the increased technical and financial costs.  

Peatlands are highly diverse, and we would encourage additional studies aimed at characterizing 

terrain at other study areas, and under different conditions. In particular, it would be interesting to 
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assess the impact of phenological condition (leaf-on, leaf-off), shadow, and atmospheric effects 

on UAV photogrammetry. The capacity of the technology seems tightly tied to the ability to 

photograph the ground reliably. Moving from general terrain characterization (spot elevations) to 

true microtopographic mapping (classifying hummocks and hollows) is another logical next step. 
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Chapter Three: UAV Remote Sensing Can Reveal the Effects of Low Impact Seismic Lines 

on Surface Morphology, Hydrology, and Methane (CH4) Release in a Boreal Treed Bog 

3.1 Abstract  

Peatlands are globally significant stores of soil carbon, where local methane (CH4) emissions are 

strongly linked to water table (WT) position and microtopography. Historically, these factors have 

been difficult to measure in the field, constraining our capacity to observe local patterns of 

variability. In this paper, we show how remote sensing surveys conducted from unmanned aerial 

vehicle (UAV) platforms can be used to map microtopography and depth to water (DTW) over 

large areas with good accuracy, paving the way for spatially explicit estimates of CH4 emissions. 

This approach enabled us to observe – for the first time – the effects of low-impact seismic lines 

(LIS; petroleum exploration corridors) on surface morphology and CH4 emissions in a treed-bog 

ecosystem in northern Alberta, Canada. Through compaction, LIS lines were found to flatten the 

observed range in microtopographic elevation by 46cm and decrease mean DTW by 15.4cm, 

compared to surrounding undisturbed conditions. These alterations are projected to increase CH4 

emissions by 20-120% relative to undisturbed areas, which translates to a total rise of 0.011-0.027 

kgCH4 d-1 per linear kilometer of LIS (~2m wide). The ~16 km of LIS present at our 61 ha study 

site were predicted to boost CH4 emissions by 20-70 kg between May and September, 2016. 

3.2 Introduction 

Peatlands – wetlands that accumulate organic matter – can release large volumes of carbon into 

the atmosphere in response to anthropogenic disturbances (Wieder & Vitt, 2006; Strack & 

Waddington, 2006; Parish et al., 2008; Vitt & Bhatti, 2012; Munir et al., 2014). Of particular 

concern is CH4: a powerful greenhouse gas (GHG) with a 20-year global warming potential 84-
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times greater than that of carbon dioxide (IPCC, 2014a; Zhu et al., 2014). The Intergovernmental 

Panel on Climate Change states that CH4 emissions from wetlands are the primary driver of 

variability in atmospheric CH4 concentrations (IPCC, 2013). However, the processes relating 

anthropogenic disturbance to wetland CH4 production and emission rates are both highly variable 

and poorly quantified, ultimately limiting our capacity to generate reliable global CH4 estimates 

(IPCC, 2014b).  

Methane flux is difficult to observe directly, and most non-point estimates rely on modeled 

associations with environmental covariates (Xu et al., 2010). For example, previous research has 

shown that CH4 is released in greater volumes in peatlands when WT is at or near the surface 

(Wieder & Vitt, 2006), and numerous studies have observed that much of the variability in peatland 

CH4 flux can be explained by differences in WT position (Kellner, Waddington & Price, 2005; 

Couwenberg & Fritz, 2012). WT estimates are commonly derived through repeated field 

measurements using monitoring wells (Lee and Cherry, 1979; Vazquez-Amábile & Engel, 2005). 

However, this method is time-consuming and spatially limited to single observation points.  

As an alternative or complement to measuring WT, many researchers have mapped 

microtopography – small-scale heterogeneities in the ground-surface elevation – for the purpose 

of upscaling point-level GHG measurements  (Nungesser, 2003; Strack et al., 2016; Becker et al., 

2008; Baird et al., 2009; Loisel & Yu, 2013). In addition to influencing CH4 flux, microforms 

(hummocks and hollows) can also foster variations in vegetation community, hydrology, nutrient 

content, and temperature across peatlands (Lucieer et al., 2010; Macrae et al., 2013; Cresto Aleina 

et al., 2015; Acharya et al., 2015). Microtopographic observations are generally easier to acquire 

than WT positions, since no water wells are necessary. In addition, the temporal persistence of 
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microforms (Nungesser, 2003) means that fewer monitoring events are required for a given site. 

Regardless, microform data still requires detailed terrain observations, which are normally 

collected with labor-intensive GPS surveys and specialized equipment (Roosevelt, 2014): a 

strategy that is expensive and difficult to scale (Pouliot et al., 2011; Roosevelt, 2014).  

Recent developments in UAV technology and related workflows have provided exciting 

new capabilities for peatland observation. UAV platforms can deliver ultra-high resolution 

imagery and 3-D point clouds (100s of points per m2) using consumer-grade digital cameras 

(Lovitt et al., 2017). In turn, these data permit the measurement of CH4 controlling factors such as 

WT position (Rahman et al., 2017) and terrain (Lovitt et al., 2017) at unprecedented levels of 

detail, with capacity for extensive spatial coverage and flexible monitoring intervals. As a result, 

UAVs present researchers with novel opportunities to investigate the impacts of anthropogenic 

disturbances on peatland ecosystem functions. 

Peatlands in the Canadian province of Alberta and elsewhere have been heavily disturbed 

by the construction of seismic lines for petroleum resource exploration (Schneider & Dyer, 2006; 

Pasher, Seed & Duffe, 2013). Seismic lines can be extremely disruptive to low-lying peatland 

ecosystems, often triggering persistent changes in environmental factors such as hydrology (van 

Rensen et al., 2015), which may have implications on GHG release rates. Low-impact seismic 

(LIS) lines are widespread in Alberta, and are deemed ‘low impact’ on account of reduced clearing 

widths (~2-3 m) compared to legacy seismic lines (~8-10 m; Schneider & Dyer, 2006; BC OGC, 

2016). However LIS are constructed in dense grid networks (~50 m intervals) across vast areas, 

and there is little evidence of enhanced recovery rates in peatlands, which are notoriously slow to 

recover from disturbance events (Schnieder & Dyer, 2006; BC OGC, 2015; van Rensen et al., 
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2015). Few studies to date have explored the impact of LIS on physical peatland conditions 

(microtopography, hydrology) and GHG fluxes. Strack et al. (2017) provides the only related 

study, which investigated GHG emissions from a conventional seismic line-turned winter access 

road within a wooded fen in northern Alberta. Their results showed that altered ecohydrological 

conditions on lines can substantially increase GHG emissions, with mean CH4 flux values 

measured at 479 CH4 m-2d-1, compared to 4.9 - 6.3 CH4 m-2d-1 in adjacent undisturbed areas (Strack 

et al., 2017).  

The focus of this research was twofold: first, to compare two UAV-based methods of 

estimating CH4 release from a treed-bog study site in northern Alberta, Canada: (i) 

microtopography and (ii) DTW; and second, to quantify the impact of LIS lines on CH4 release, 

microtopography, and DTW across our 61 hectare study site. Our work represents the first-known 

spatially explicit quantification of LIS impacts on morphology, hydrology, and chemistry on 

peatlands in Canada. 

3.3 Materials and Methods 

3.3.1 Study site. 

The study site is a ~61 ha portion of treed bog located roughly 35 km northeast of Peace 

River, Alberta (Figure 3.1a). Treed bogs are a type of wetland that receive water exclusively from 

precipitation (no input from surrounding watersheds), and accumulate organic matter (peat) on 

account of their low-oxygen environment (National Wetlands Working Group, 1997). Within our 

study site, a 3.8 ha subset area (Figure 3.1b) was used to assess model accuracies and generate 

CH4 estimates for up-scaling across the full site. The study area is heavily disturbed by resource 

exploration and extraction activities. A mineral-filled access road traverses the eastern portion of 
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the site, and the center is bisected by a pipeline. However, the main focus of the present work is 

the dense network of ~2-m wide LIS lines, which total 16 km in length within the study area and 

1.4 km in length within the subset area. In the undisturbed portions of the bog, microforms 

(hummocks and hollows) are present at scales from 30-cm to 1-m diameter and height, and occur 

in roughly equal proportions. Vegetation is typical of treed bogs within the region, with black 

spruce (Picea mariana) being the dominant tree species, labrador tea (Rhododendron 

groelandicum) and small cranberry (Oxycoccus microcarpus) representing the majority of shrub 

species, and Sphagnum spp. (Sphagnum fuscum - rusty peat moss, Sphagnum capillifolium - acute-

leaved peat moss, Sphagnum girgensohnii - Girgensohn's peat moss, Sphagnum magellanicum - 

midway peat moss, Sphagnum warnstorfii - Warnstorf's peat moss) dominating the ground layer. 

Zones disturbed by LIS appear as linear clearings with apparent flattening of microtopography. In 

many cases, the remnants of vehicle tracks were observed along these features, having formed 

pools of standing water surrounded by vascular vegetation more commonly found in fen 

ecosystems, including willow (Salix spp.) and a variety of sedges. Repeated vehicle use on seismic 

lines in this study area was not observed, suggesting the tracks were created during initial 

construction. 
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Figure 3.1: Full Study Site Extents (3.1a) and Subset (3.1b) Showing Equal Area Polygons and 
Seismic Lines used to Generate Methane Flux Estimates from MT and DTW Surfaces (Process 
Explained in Section 2.2.3.3). Within Figure 3.1b, a variety of surface features can be observed 
including dispersed pockets of dense black spruce. 
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3.3.2 Field-Measured CH4 Flux (Point Samples). 

Methane samples were collected at 27 points (collars) every second week over a 150-day 

monitoring period, which ran from May to September of 2016. Collars were permanently installed 

across 14 hollows and 11 hummocks in order to capture a range of data for each identified 

microform type. These collars were measured as part of another study investigating the impact of 

a permanent access road on peatland carbon exchange, but any collars in areas specifically 

impacted by road construction (i.e., where vegetation had been disturbed) were not included in the 

present dataset. Since the road has impacted hydrology at the site, some of the measurement collars 

were likely wetter or drier than would have occurred in undisturbed conditions, which allowed for 

a wider range of DTW to be considered. Therefore, although no collars were specifically located 

on seismic lines, they do represent the full range of microtopography and WT position present 

across the site. Prior to collecting the gas samples, a closed opaque chamber (60 cm x 60 cm x 30 

cm) was fitted over each collar and sealed from the atmosphere (Tuittila et al., 2000). An internal 

fan mixed headspace air, and a 20-mL syringe was used to collect gas samples at pre-determined 

intervals (7, 15, 25, and 35 minutes). A thermocouple was used to determine the chamber’s internal 

air temperature at the time each sample was collected. Gas samples were then stored in pre-

evacuated Exetainers (Labco Ltd., UK) and shipped to the University of Waterloo for analysis. On 

each sampling day, four ambient gas samples were also collected to provide background CH4 

concentrations at the study site, and the WT position of wells installed beside each collar was 

recorded.  

The CH4 concentration of each sample was analyzed using a Shimadzu GC-2014 gas 

chromatograph (GC), at the University of Waterloo, and CH4 flux was determined from the linear 
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change in concentration over time. Flux measurement with a poor linear relationship (R2 < 0.75) 

were deemed indicative of chamber disturbance during measurement, and were removed from the 

dataset. These instances generally occur due to ebullition, and indicate that CH4 flux is likely 

poorly represented by our chamber measurements (as in other studies such as Christen et al., 2016). 

Therefore, flux estimates and the calculated impact of seismic lines on ecosystem CH4 flux are 

likely conservative. Fluxes in which no change in CH4 concentration was noted (i.e., change in 

concentration was within the precision of the GC of 0.5 ppm) were assigned a value of zero. 

Approximately 10% of the data was removed following these protocols. Accepted CH4 fluxes were 

then corrected for both internal chamber air temperature and chamber volume.  

Flux sampling points were identified as either hummocks or hollows based on vegetation 

and microtopographic characteristics. From this segregation, the average CH4 flux per microform 

(hummock vs. hollow) was calculated. We then determined the relationship between CH4 emission 

and DTW by applying a LOG10 transformation to the 150-day mean CH4 flux data of each plot, 

and performing a linear regression with mean WT position of each corresponding water well. 

Previous studies have noted that a log-linear relationship exists between CH4 flux and WT position 

(Moore and Roulet, 1993, Bubier et al. 1993). The LOG10 approach was found to improve both 

the normality of the CH4 flux data distribution, and residual errors of the regression. Across all 

sampling plots, the relationship between CH4 flux and WT position (p < 0.01; R2 = 0.28; Figure 

3.2) was described by the following equation:    

log10(CH4) = 0.0305*WTposition + 1.5257 [1] 
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Figure 3.2: Relationship between LOGCH4 (mgm-2d-1) and Water Table position (cm), where 
water table located below ground surface is given a negative value. Error bars indicate the 
standard error of LOGCH4 values (±0.13). 

 
3.3.3 Remote Sensing Observations. 

UAV data were acquired on September 2, 2016 using an Aeryon Skyranger fitted with an 

HDZoom30 RGB optical camera (20 megapixels, global shutter). The flight was completed 

between 9:30 am and 2:00 pm at 110 m altitude with approximate wind speeds of 3m/s. Data were 

collected continuously during flights (flight speed 4 m/s) to minimize battery replacements (3 for 

full site coverage), with flight lines positioned to deliver 80% endlap and 60% sidelap amongst 

photographs. Ground resolution of the resulting dataset was approximately 2 cm. Lighting was 

diffuse and low during flight operations due to persistent high cloud cover, thereby minimizing 

the amount of shadow in the imagery. It’s worth noting that small pools of standing water were 

dispersed across the site resulting from very wet conditions leading up to flight operations. These 

pools may have influenced UAV product accuracies due to increased surface homogeneity and 

reflectivity, though accuracies of the resultant dense point cloud and digital surface models (DSM) 

were deemed sufficient to proceed with secondary analyses.    
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3.3.4. Classification of Terrain (Microtopography). 

 

Figure 3.3: The workflow for generating microtopographic surface.  

 
The workflow used to generate a classified microtopography surface is summarized in 

Figure 3.3. From the aerial data, a dense point cloud comprised only of ground points, which we 

call the ground dense point cloud (gDPC), was generated as per Lovitt et al. (2017). Accuracies of 

the gDPC were estimated by PhotoScan (Version: 1.2.4) as ~0 cm (x,y) and 21 cm (z). Nearest-

neighbour interpolation was applied to the gDPC in ESRI ArcMap (Version: 10.3.1) to generate 

the DTM. Using ENVI (Version 5.1) we then applied a mask, buffered by 18 pixels, over treed 

areas, followed by a low-pass filter (window size 2 m) to generate a reference surface (Ref) 

representing general site slope. The purpose of buffering the tree mask was to ensure that 
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vegetation edge points (ie. points falling on the boundary between terrain and tree, as per Lovitt et 

al. 2017) were excluded from the low-pass filter calculation. The purpose of excluding these points 

was to avoid artificially increasing ground-surface elevations in areas where points represented 

vegetation rather than ground. A window size of 2 m was selected for the low-pass filter after 

comparison with window sizes of 1 m, 1.5 m, and 3 m. In order to ensure ENVI was excluding 

masked areas (assigned 0 value) in the averaging window calculation, we applied a custom IDL 

script which forced ENVI to average pixels with non-zero values only. Finally, after generating 

Ref, we subtracted it from the DTM [DTM-Ref] to generate a microtopography elevation surface 

(MT; Figure 3.4). 

We classified the MT surface using a simple, pixel-based density slicing approach in ENVI. 

A total of three classes were identified across the site: (i) hummocks, (ii) hollows, and (iii) trees. 

The classification specified hummocks > 0, hollows < 0, and trees = 0 (masked).  The approach 

was based on the assumption that areas taller than the average elevation of the surrounding 

peatland (positive MT surface values) corresponded to hummocks, while areas below the average 

elevation (negative MT surface values) corresponded to hollows (Figure 3.4).  
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Figure 3.4: Process of producing the microtopography surface by subtracting the reference 
surface (Ref) from the digital terrain model (DTM). Areas above Ref are considered hummocks 
(brown), areas below are considered hollows (light blue), and areas which are masked are 
assigned the class ‘Trees’.  

 
Classification accuracy was assessed by generating a confusion matrix using 105 validation 

points collected in the field. Samples were selected using a stratified-random sampling strategy, 

and observed locations were surveyed using a Trimble R4 real-time kinematic (RTK) global 

navigation satellite system (GNSS) system. In addition to this ground data, 50 random points 

representing tree pixels were selected for assessment of the tree class. Results of this classification 

are summarized in Table 3.1. The overall accuracy of the classification was 84% (kappa: 0.76). 

This classification performed good overall, though it resulted in a slight over-representation of 

hollows (86% producer’s accuracy vs. 77% user’s accuracy), and a slight under-representation of 

trees (92% producer’s accuracy vs. 100% user’s accuracy) across the site. However, there appears 

to be no bias in the classification of hummocks (75% producer’s accuracy vs. 77% user’s 

accuracy). The majority of errors in distinguishing hummocks and hollows were found to occur in 

cases where the target microform was within ±5 cm of the reference surface, an area we define as 

the microform ‘transition zone’. The accuracy of the classification was comparable to results 
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reported in similar studies (Lehman et al., 2016), and was therefore deemed acceptable for use in 

estimating CH4 emissions and disturbance related changes in microtopography. 

 
Table 3.1. Confusion Matrix of Pixel-Based Density Slicing Classification Approach 

(Overall Accuracy = 84%; kappa = 0.76) 

  Reference   

 n = 155 Hummock Hollow Trees Total 
User’s 

 Accuracy (%) 

P
re

di
ct

ed
 

Hummock 40 8 4 52 77 

Hollow 13 44 0 57 77 

Trees 0 0 46 46 100 

Total 53 52 50 155   

 Producer’s  
75 86 92     

 Accuracy (%) 
 

3.3.5. Generating the Depth to Water Surface (DTW) Surface. 

The DTW surface was generated using the methods described by Rahman et al. (2017). In 

their workflow, areas of stable open water were first classified using a decision-tree classification 

scheme. From among the resulting classified pixels, spatially distributed samples of open water 

were selected, and their elevations interpolated via ordinary kriging to obtain the height of the WT 

in meters above mean sea level (masl). The groundwater-level surface was then subtracted from 

the DTM to obtain DTW. The accuracy of the DTW surface was assessed as per Rahman et al. 

(2017). Validation of the DTW surface was completed by comparing modeled values against field 
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data collected at five wells within the study site. The results of this comparison indicated an RMSE 

of the DTW surface in the study area subset of 11.3 cm. 

Since WT fluctuates throughout the year, we needed to adjust the DTW surface estimated 

at the date of the UAV flight on September 2 in order to reflect the mean value of DTW across our 

flux monitoring period from May to September. True point measures of DTW were observed at 

37 water wells across the study area by field personnel every two weeks. We selected the well 

which was located closest to our 3.8 ha subset area, and averaged all measurements to determine 

the mean DTW in the well over the 150-day monitoring period. We then compared this value with 

that estimated from our UAV model at the well’s location (collected as part of the terrestrial survey 

via RTK GNSS). This comparison revealed that the mean DTW, as calculated from the water well 

data, was 4.8 cm lower than the DTW position estimated by the UAV model for September 2. As 

a result, we lowered the DTW model by 4.8 cm to better reflect the seasonal average. This 

adjustment assumes that WT fluctuates consistently across the site, and that averaging the collected 

data from one sampling point is sufficient to estimate mean WT position across the larger area. 

3.3.6. Predicted CH4 Flux. 

The subset area was divided into 32 equal-area quadrats (~1189 m2 each) to allow for a 

statistical analysis of flux estimates within each quadrat (Figure 3.1b). Seismic lines were manually 

digitized from the high-resolution UAV orthophoto in ESRI ArcMap 10.3.1. We clipped the MT 

and DTW layers using seismic-line boundaries to divide the study site into two categories: 

undisturbed and disturbed. CH4 emissions were then estimated from each category (undisturbed: 

MT & DTW, disturbed: MT & DTW) for each of the 32 polygons. 
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Figure 3.5 provides a visual representation of surfaces used in predicting CH4 emission. To 

estimate CH4 fluxes from the MT surfaces, the percent-area coverage of hummock, hollow, and 

tree (undisturbed) was calculated and multiplied by the corresponding average fluxes of 13.3, 34.5, 

and 24.3 mgCH4 m-2 d-1. The standard errors of these fluxes were estimated as 3.8, 9.5, and 0.09 

mgCH4 m-2 d-1, respectively. As CH4 fluxes were not directly measured in areas below trees, we 

assigned average CH4 values to treed areas. Based on field observations of microtopographic 

conditions below trees, no discernable pattern in microform occurrence in these areas was 

identified, so applying an average flux value was considered appropriate. This approach involved 

calculating the average flux for undisturbed and disturbed portions of the polygon, estimated 

exclusively by the areal coverage of classified hummocks and hollows in these areas. Since this 

method estimated greater CH4 emission within disturbed areas (higher occurrence of hollows), a 

slightly higher average flux value of 26.1 mgCH4 m-2 d-1 was used for trees in these areas. The 

standard error of this flux was estimated as 0.3 mgCH4 m-2 d-1.  

To estimate CH4 flux from the DTW surface, equation [1] was applied to the DTW surface. 

This produced a CH4 surface with flux values across the site at 2 cm resolution. The same buffered 

tree mask was then applied to the DTW surface to ensure flux estimates between the DTW and 

MT surface were comparable. Similar to the MT surface, treed areas were assigned an average 

flux value based upon their surrounding conditions; i.e., Trees [undisturbed]: 12.2 mgCH4 m-2 d-1 

, Trees [disturbed]: 27.5 mgCH4 m-2 d-1 with a corresponding standard error of 1.0 and 3.6 mgCH4 

m-2 d-1.   
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Figure 3.5: Graphical visualization of digital surfaces generated from the input surface model 
(shown at top of stack). Surfaces include the bare earth and water table (WT), microtopography, 
depth to water (DTW) and CH4. DTW is shown in centimeters where depths below ground surface 
are negative, CH4 is shown in mgCH4 m-2 d-1. The DTW surface was derived from the bare earth 
and WT surfaces, the arrow shows this link to the WT position below ground surface. Figure 
prepared by Robin Poitras and Julie Lovitt at the University of Calgary. 
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3.4 Results 

3.4.1 Seismic Line Impacts on Microtopography and DTW. 

Mean ground elevations were significantly different between undisturbed and disturbed 

areas (p<0.01), with seismic lines occurring 2.2 cm lower on average relative to undisturbed peat 

(RMSE: 2.6 cm). Additionally, an overall flattening of microtopographic features was noted along 

LIS (Figure 3.5, microtopography), with the majority of microforms existing within ±5 cm of Ref. 

By comparison, greater variation in ground-surface elevations was noted in undisturbed areas, 

specifically an increased occurrence of tall hummocks (i.e. ground > 10 cm of Ref). Ground 

elevations in undisturbed areas (32 total polygons) ranged from -74 cm below to +97 cm above 

Ref, with a mean value of 0.6 cm. Comparatively, elevations in disturbed areas (27 total polygons) 

ranged from -64 cm to +64 cm, with a mean value of -1.5 cm (Table 3.2). This translates to a 46-

cm reduction in the average microform elevation range within seismic lines.  

A near-equal frequency of hummock vs. hollow occurrence was noted in undisturbed areas 

(51.8% hollow coverage). However, an increase in hollow prevalence (60.8% coverage) was 

observed along seismic lines (Table 3.2).  
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Table 3.2. Summary Table Showing Absolute and Average Differences in Microform 
Heights, Percent Coverage and Measured Depth-to-Water between Undisturbed and 
Disturbed Areas 

   Undisturbed  
(32 Polygons) 

Disturbed  
(27 Polygons) 

M
ic

ro
fo

rm
 H

ei
gh

t (
cm

) 
 

A
bs

ol
ut

e Minimum -74 -64 

Maximum 97 64 

Range 171 128 

A
ve

ra
ge

 

Minimum -48 -30 

Maximum 69 41 

Range 117 71 

Mean 0.6 -1.5 

Hummock/Hollow Coverage (%) 48.2/51.8 39.2/60.8 

  

D
ep

th
-t

o-
W

at
er

 (
cm

) 

A
bs

ol
ut

e Minimum -159 -81 

Maximum 71 39 

Range 230 120 

A
ve

ra
ge

 Minimum -95 -40 

Maximum 24 21 

Range 119 61 

Mean -17.5 -2.1 
 
 

Significant differences in DTW were found to exist between seismic lines and undisturbed 

peatland areas (p <0.01). In undisturbed areas, DTW ranged from 159 cm below to 71 cm above 

ground surface, with a mean value of 17.5 cm below surface (Table 3.2). Along seismic lines, 

DTW ranged from 81 cm below to 39 cm above ground surface, with a mean value of 2.1 cm 

below the surface. Comparing average values suggests that little difference exists in maximum 
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DTW values between undisturbed areas (24 cm) and disturbed areas (21 cm). However, there were 

clear differences in the calculated average minimum DTW values (-95 cm vs. -40 cm respectively). 

This indicates that a shallower WT position exists along seismic lines (average difference 15.4 cm; 

RMSE: 17.5 cm). 

3.4.2 CH4 Flux Estimates and Quantification of Seismic Line Impacts. 

Table 3.3 summarizes partial (undisturbed vs disturbed) and total (undisturbed + disturbed) 

CH4 flux estimates for the study site as calculated by both surfaces (MT and DTW), as well as 

estimated increase (%) of CH4 along seismic lines. Significant differences were noted between the 

two surfaces when predicting CH4 flux in undisturbed areas (p<0.01) but not along seismic lines 

(p=0.454). Total CH4 for the 3.8 ha study site over the 150-day flux monitoring period was 

estimated as 124 kg (MT), and 76 kg (DTW), resulting in the MT surface estimating +48 kgCH4 

more than the DTW. The correlation between the two surfaces’ estimates in undisturbed areas was 

slightly lower (0.55) than that observed in disturbed areas (0.69). Methane emissions are predicted 

to increase substantially (MT: +20%, DTW: +120%) on seismic lines relative to undisturbed 

peatland. Results of the statistical analysis indicate that these differences are significant (p<0.01) 

in both surfaces (MT & DTW).     
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Table 3.3. Predicted CH4 Emissions (standard error) of 3.8ha Subset Study Site over 150-
day monitoring Period and Estimated Increase (per ha) due to Seismic Line Disturbance  

 MT Surface DTW Surface 

Undisturbed  Total Estimated CH4 Flux (kg·d-1) 0.759 (0.0003) 0.433 (0.0006) 
 

Total Area (ha) 3.78 3.78 
 

Avg Predicted Flux (kg·ha-1
·d-1) 0.216 (0.1) 0.123 (0.3) 

 

 

  

Disturbed  Total Estimated CH4 Flux (kg·d-1) 0.070 (0.0003) 0.072 (0.0004) 
 

Total Area (ha) 0.269 0.267 
 

Avg Predicted Flux (kg·ha-1
·d-1) 0.261 (0.3) 0.270 (3.0)  

 

  

Total Site  CH4 Increase per ha due to Disturbance  20% 120% 

 
Percent of Site Disturbed 7% 7% 

Total Predicted Flux for Site  
(kg·3.8 ha-1·150 d-1) 

124 76 

 
To estimate CH4 flux per linear kilometer of LIS, we multiplied predicted CH4 flux (in kg 

per m2 d-1) by the estimated line width (2 m) and length (1000 m). Both surfaces estimate 

approximately 0.050 kgCH4 d-1 per linear kilometer of LIS (MT: 0.052 kgCH4 d-1, DTW: 0.054 

kgCH4 d-1). This translates to an increase between 0.011 and 0.027 kgCH4 d-1 per linear kilometer 

of LIS. These values can be adjusted to represent older, legacy lines of varying widths as desired. 

Table 3.4 presents estimates of CH4 flux across the entire 61 ha study site. Excluding other 

disturbance features (pipeline and road) LIS account for approximately 5.2% of the total site 

coverage. Assuming the site had 0% seismic line disturbance, total site CH4 emission estimated 

over the 150 day monitoring period is predicted to be between 1,130 kgCH4 (DTW) and 1,990 

kgCH4 (MT). The standard error for these values is estimated to be 30 and 13 kgCH4 respectively. 

Adjusting these predictions to include 5.2% LIS disturbance, total CH4 emission estimates increase 
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to 1,200 kgCH4 (DTW) and 2,010 kgCH4 (MT), with standard errors of 15 and 2 kgCH4, 

respectively. This translates to an absolute total site CH4 emission increase at the 61 ha site over 

the 150 day monitoring period of approximately 70 kg and 20 kg, respectively.  

Table 3.4. Estimated Total CH4 Emission across 61 ha Study Site (as per Figure 3.1a) and 
Predicted Increase over 150 day monitoring Period due to Seismic Line Disturbance 
  

Undisturbed Disturbed 

Areal Coverage 94.8% 5.2% 

MT Flux (kgha-1d-1) 0.216 0.261 

DTW Flux (kgha-1d-1) 0.123 0.270 
   

 
MT Surface DTW 

Surface 
Total Predicted Flux in Undisturbed Areas (kg·ha-1·d-1) 1.25 0.71 

Total Predicted Flux in Disturbed Areas (kg·ha-1·d-1) 0.08 0.09 

Theoretical Total Predicted Flux of Site (%coverage of LIS = 0) 
(kg·ha-1·d-1) 

1.32 0.75 

Actual Total Predicted Flux of Site (%coverage of LIS = 5.2) 
(kg·ha-1·d-1) 

1.33 0.80 

Absolute Total Site CH4 Increase due to Disturbance  
(kg ·61ha-1·150d-1) 

20 70 

 
Using the 0% disturbance-site flux values, we performed a sensitivity analysis of calculated 

CH4 emissions across the study site over the 150 day monitoring period, based on the errors 

documented for both surfaces (11.3 cm RMSE for DTW; 84% for MT). The DTW surface was 

regenerated twice: once lower (DTW minus 11.3 cm) and once higher (DTW plus 11.3 cm) based 

on reported RMSEs. These adjustments produced estimated CH4 fluxes ranging from 960 

kgCH4·61ha-1·150d-1 (DTW minus 11.3 cm) to 2,200 kgCH4·61ha-1·150d-1 (DTW plus 11.3 cm), 

revealing the estimated uncertainty in our DTW generated CH4 predictions. We did a similar 

analysis for the fluxes estimated from the MT surface, both increasing (plus 16%) and decreasing 
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(minus 16%) the proportion of hummocks to hollows, based on reported accuracies. These 

adjustments produced estimated CH4 fluxes ranging from 1,480 kgCH4·61ha-1·150d-1 (proportion 

of hummocks plus 16%) to 2,200 kgCH4·61ha-1·150d-1 (proportion of hollows plus 16%). Again 

we interpret this as an estimate of uncertainty in our MT generated CH4 predictions. The sensitivity 

analyses reveals greater uncertainty in CH4 estimates arising from the DTW surface (960-2,200 

kgCH4·61ha-1·150d-1) than the MT surface (1480-2,200 kgCH4·61ha-1·150d-1). 

3.5 Discussion  

We conducted a thorough comparison of peatland microtopographic and DTW characteristics 

across our study area to determine how seismic lines have impacted these key environmental 

factors. Results of this assessment indicate that LIS lines at the study site caused an overall 

flattening of microforms, increase in hollow frequency, and decreased the mean ground elevations 

by 2 cm (RMSE: 2.6 cm). These same disturbances decreased mean DTW by 15.5 cm. By 

comparison, a study investigating permafrost-related impacts in Canada’s Northwest Territories 

showed that seismic lines on permafrost peatlands produced ground subsistence between 3 and 53 

cm (Williams, Quinton & Baltzer, 2013). While these dramatic results are caused at least in part 

due to altered permafrost regimes along seismic lines, they reflect the trends observed in our 

analysis: LIS lines stand out from the surrounding peatland as lower, wetter, and flatter areas. 

Assuming that our study site is indicative of typical treed bog conditions, these findings can 

partially explain the lack of successful ecosystem recovery (i.e. restoration of ground surface, 

hydrological and vegetation conditions comparable to pre disturbance) along linear features within 

the western Canadian Boreal region. Van Rensen et al. (2015) indicated wetter (flooded) areas are 

less likely to establish new Sphagnum moss communities, an important genus in natural hummock 
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formation. This suggests LIS lines within our study site, and those in comparable disturbed 

peatlands, are highly unlikely to recover without the pursuit of active restoration designed to 

recreate suitable surface conditions.  

Furthermore, the results of our CH4 flux estimates indicate the strength of the link between 

lower, wetter peatland conditions, as found along LIS, and significantly increased CH4 emissions. 

Both MT and DTW surfaces predict CH4 release increases between 20% (MT) and 120% (DTW) 

along LIS (2 m width) compared to adjacent undisturbed areas. Logically, it follows that wider 

conventional lines, such as those constructed in the mid 1950’s, would produce even higher CH4 

emission per linear kilometer. Considering these wider lines have been linked to other altered 

environmental conditions, including light exposure and surface temperatures (Dabros et al., 2017), 

these increases in CH4 emission may be exponential, and the cumulative emission of unreclaimed 

LISs over their lifespan is likely to be highly significant.  

In this study, microtopography and DTW were modelled from UAV data with good results 

(MT: 84% overall accuracy, DTW: 11.3 cm RMSE), though uncertainties within these layers 

persist. Our sensitivity analyses reveal these uncertainties to produce greater variability in CH4 

output from the DTW surface. This is perhaps predictable, given the simpler nature by which CH4 

estimates are up-scaled with the MT surface, using a small number of averaged microform fluxes. 

However, it also reflects the fact that the log-linear equation [1] of the DTW approach is highly 

sensitive to the quality of input water-level data; small errors in estimated WT position may 

produce large uncertainty in CH4 predictions. Unfortunately, we had insufficient flux data to 

perform an accuracy assessment of CH4 estimates: something that should be pursued in future 

research.   
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Lacking a proper model validation, we assume the more technically complex DTW surface 

is better representative of real world conditions in undisturbed areas due to the higher spatial 

resolution of CH4 estimates. This is in line with previous studies that indicate simple classifications 

are likely to over- or under-estimate CH4 emission (Hartley et al., 2015; Lehmann et al., 2016). 

However, there was no significant difference in estimates from either surface along seismic lines. 

The higher estimation of the MT surface within undisturbed areas is likely due to the wide range 

of flux rates reported across microforms of differing heights (hummocks) and depths (hollows). 

We suggest including additional classes of microforms may address this issue by accounting for 

greater variability in both microforms and CH4 emission rates within undisturbed peatland areas 

(Bubier et al., 1993). Furthermore, this may overcome classification issues in differentiating 

hummocks from hollows as the majority of these errors were found to occur in in the transition 

zone, the area between clearly identifiable microforms (±5 cm of Ref). Alternatively, a Lawn class 

could be created to capture areas within the transition zone, entirely replacing the need for 

‘Transitional Hummock’ and ‘Transitional Hollow’ classes. Bubier et al. (1993) define lawns as 

areas which are relatively flat compared to the surrounding peatland surface. In this case, areas 

within the identified transition zone would fit the description of lawns as they are within 5 cm of 

the mean peatland surface elevation.   

3.5.1 Potential Sources of Error 

As described in Lovitt et al. (2017) and Rahman et al. (2017) numerous external factors, 

such as weather conditions during UAV operations and input model accuracies (ie. DTM, water 

level surface), may have affected the accuracy of our results. These factors were addressed in their 

respective manuscripts and will not be discussed further.  
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The microtopographic classification method applied in this study could be improved. Due 

to the slight over representation of hollows, the MT surface likely overestimates CH4 flux in 

undisturbed areas, and comparatively underestimates the impact of seismic lines. Similarly, the 

inclusion of vegetation border points during DTM generation caused us to apply an 18 pixel buffer 

to the tree mask which likely removed useful terrain pixels from the MT surface.  

Predicting CH4 emission from the MT surface was limited by a lack of CH4 measurements 

across a variety of microform heights. As a result, average flux values were applied to only three 

microform classes (hummocks, hollows, and trees), which likely overestimated flux from 

undisturbed areas. Although CH4 estimates from the DTW surface were anticipated to be more 

accurate than the MT surface, the reported R2 value (0.28) of the LOG(CH4) linear equation [1] 

may explain a degree of uncertainty in the results. While this R2 value is comparable to similar 

studies (Moore & Roulet, 1993: R2 = 0.332), others have reported stronger relationships between 

peatland CH4 flux and WT position (Bubier et al., 1993: R2 = 0.649; Shannon & White, 1994: R2 

= 0.58, Sundh et al., 1994: R2 = 0.50, Bubier, 1995: R2 = 0.74), Therefore, expanding the CH4 

dataset (spatially or temporally) may strengthen the relationship between CH4 flux and WT 

position, and improve CH4 estimates from the DTW surface. Conversely, this R2 value may 

indicate that other environmental factors have greater influence on CH4 generation and emission 

at this study site. For example, previous studies indicate that soil temperature may influence bog 

CH4 flux (van Winden et al., 2012), and vegetation type is often a strong predictor of peatland CH4 

flux (Bubier, 1995; Couwenberg et al., 2011).  

It was beyond the scope of this paper to investigate other disturbance features present at 

the study site (pipeline and road). However, these features likely have similar impacts on peatland 
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hydrology and microtopography, and we recommend future research on how they may alter 

peatland CH4 release. Moreover, peat composition and biogenic gas distribution is anticipated to 

be comparable across the entire 61 ha study site, which may not be the case if woody debris or 

confining layers, such as peat with low permeability, vary (Comas et al., 2014). Therefore, these 

methods of estimating CH4 emissions across large areas may need to be modified by site-specific 

criteria prior to application. 

3.6 Conclusions 

The primary objective of this research was to use UAV data to quantify the impact of seismic lines 

on peatland CH4 emissions, microtopography, and DTW within a boreal treed bog in northern 

Alberta, Canada. From this investigation, we determined that seismic lines have significant 

impacts on the peatland ecosystem, causing overall flattening of microtopography and decreasing 

DTW, resulting in significant increases in CH4 release. Based on this assessment, and the 

knowledge that seismic lines are widespread within the western Canadian Boreal region, we 

suggest these linear disturbances should be included in land-use change GHG emission estimation 

to avoid under-reporting at the national scale. Furthermore, due to the noted degree of 

microtopographic and DTW disturbance, we posit that active restoration will likely be necessary 

to achieve recovery of vegetation and ecosystem function along LIS. Additional data are required 

to properly validate the CH4 flux estimates and determine which UAV method is superior; 

however, we believe the relationships presented here (significant increase in CH4 emission along 

seismic lines) are valid based upon the assessment of altered physical parameters 

(microtopography and DTW). 
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 This research represents an initial attempt to determine how LIS have altered boreal 

peatland carbon balance and storage functions at a single treed bog in northern Alberta. However, 

peatlands are incredibly diverse ecosystems and we encourage additional studies building upon 

our methods, and/or aimed at investigating similar disturbance features within different peatland 

types. Moreover, assessing the impact of mineral-filled linear disturbances, such as pipeline right 

of ways and resource roads, would be beneficial. Additionally, it would be useful to up-scale these 

findings to the regional level, and/or adjust national GHG estimates to include disturbance features, 

especially considering key points in the current provincial government’s Climate Leadership Plan 

have been identified as reducing CH4 emissions by 45% by 2025, and improving management of 

industry GHG emissions (GoA, 2017). 
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Chapter Four: Conclusions 

The link between ecosystem disturbance and increased greenhouse gas (GHG) release is well-

documented in eastern Canadian peatland complexes (Strack & Waddington, 2012; Strack & 

Zuback, 2013; Macrae et al., 2013). However, very little research to date has focused on how 

western Canadian Boreal peatlands respond to small-scale disturbances such as seismic lines and 

other non-mineral-fill related linear features (power transmission lines, winter roads, pipelines, 

etc). Though more recently constructed seismic lines are considered low-impact due to their 

relatively small local scale (2m widths), it is anticipated their high-density construction design will 

have significant, compounding effects on peatland surface conditions and hydrology, and therefore 

GHG flux (Weider & Vitt, 2006; Graf, 2009). The research presented here strives to address this 

knowledge gap by describing methods for leveraging cost-effective UAV technology to 

characterize and assess terrain (microtopography) within a complex peatland of northern Alberta, 

Canada. These methods are based on the assumption that microtopography indirectly describes 

environmental conditions controlling peatland GHG generation and distribution, and can therefore 

be used to predict changes in CH4 release between disturbed and undisturbed areas. Results of this 

research indicate that UAVs are suitable for mapping peatland microtopography under all but the 

most complex surface conditions, and provide the first-known spatially explicit quantification of 

seismic-lines impacts on physical peatland parameters (hydrology and microtopography), and CH4 

emission. These findings suggest that it is vital to include estimates of linear features when 

calculating peatland carbon stocks, specifically in the sedimentary basin of western Canada, where 

seismic-line disturbances are ubiquitous (Schneider & Dyer, 2006).   
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4.1 Research Objectives Summary 

The overall goal of this research was to assess the suitability for UAVs to map and classify peatland 

terrain, and to use these data to estimate seismic line impacts on peatland surface, hydrology, and 

methane emission. The research objectives were as follows: 

1. To assess the capacity of UAV photogrammetry for modelling microtopography in 

complex peatland systems within Alberta by: 

a. Assessing the accuracy of modelling peatland microtopography using UAV 

photogrammetry, and 

b. Developing a method for characterizing (classifying) peatland surface morphology 

using UAV imagery 

2. To quantify the impact of seismic lines on physical environmental parameters 

(microtopography and depth-to-water), and CH4 emission, in a typical treed bog of 

northern Alberta 

A summary of research activities made in addressing these objectives is summarized below: 

 (Objective 1a) A review of the literature, as summarized in Chapter 1, revealed the need 

for an efficient and economical method for collecting the spatially explicit, high-resolution 

data required to accuratly map peatland microtopography, and capture CH4 hotspots across 

the larger landscape. While unmanned aerial vehicles (UAVs) fitted with passive sensors 

have been shown promise in open peatland complexes, they had yet to be tested in the more 

complex treed peatlands of western Canada. As the use of UAVs was critical to this 

research program, I completed an accuracy assessment to determine whether models 

developed from the UAV data would be of sufficient quality to proceed with the subsequent 
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research objectives. As part of this assessment, I also tested whether the UAV point cloud 

could be enhanced by using complimentary LiDAR data to fill in data gaps caused by 

densely treed vegetation. Results of this assessment revealed that UAV photogrammetry 

data alone are appropriate for collecting microtopographic data under all but the most-

complex surface conditions of a treed bog, with no notable benefit found by incorporating 

LiDAR. Additionally, there was no significant difference in UAV model accuracies in 

areas disturbed by linear features (pipeline, seismic lines etc.) and sparsely treed 

undisturbed peatland areas. This lead to the conclusion that UAVs are appropriate 

platforms for collecting peatland microtopographic data, and also for comparing peatland 

surface conditions between undisturbed peatland and areas disturbed by linear features. 

This second conclusion was essential to proceed with the quantification of seismic line 

impacts on the treed bog ecosystem (Research Objective 2).   

 
 (Objective1b). Once the accuracy assessment had been completed, a method of converting 

ground elevation data to meaningful microtopographic information had to be developed. 

There were two main reasons for completing this objective: 1) to facilitated meaningful 

comparisons of microform characteristics in undisturbed and disturbed (via seismic line) 

areas, and 2) to use the classified surface in quantifying seismic line impacts on CH4 

emission, and up-scale CH4 flux to the larger study area (Research Objective 2). I devised 

a simple classification scheme, based on the assumption that elevations greater than the 

local (2m) average would correspond with hummocks, while those below the local average 

would correspond with hollows. Applying this workflow to the digital terrain model 
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effectively divided the study area into meaningful classes of hummocks, hollows, and trees 

(masked areas). Assessment of the classification confusion matrix indicated that the overall 

accuracy was sufficiently high (84%) for use in characterizing CH4 flux. This approach to 

microform classification was highly successful in differentiating tall hummocks and deep 

hollows, but performed less well when differentiating smaller microforms within 5cm of 

the local (2m) average surface. Results could potentially be improved with further 

segregation of the hummocks and hollows classes. In particular, the identification of a 

transitional microform class, which would capture points ±5cm of the local average 

surface, would likely address the majority of commission errors. 

 
 (Objective 2) The final objective was to quantify seismic line impacts on peatland 

environmental conditions and CH4 emissions. To quantify seismic line impacts on peatland 

environmental conditions and CH4 emissions, I used the microtopographic (MT) surface 

(from 1b) and a depth-to-water (DTW) surface generated by a colleague (Rahman et al., 

2017) to estimate CH4 emission across the study area. A thorough comparison of 

undisturbed peatland conditions (MT, DTW, and CH4 flux) and those of areas disturbed by 

seismic lines was then completed. Results of this assessment reveal significant differences 

between undisturbed peatland conditions and those of seismic lines. In particular, dramatic 

increases in CH4 release (up to 120% per linear kilometer) was estimated along seismic 

lines. Predicted CH4 flux was found to be significantly different between the two surfaces 

(MT and DTW) when modeling undisturbed peatland areas, but not along seismic lines. 

Additional data is required to determine which model more accurately estimates flux within 
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the undisturbed peatland areas. Results of the microform comparison indicate peatland 

microtopography was flattened along seismic lines, with a reported maximum decrease in 

hummock height of 33cm and maximum decrease in hollow depth of 10cm. Additionally 

the water table position was found to be shallower by 15.5cm (on average) along seismic 

lines when compared with DTW of undisturbed areas. When considered cumulatively, 

these seismic-line impacts appear to be severe as they not only result in greater CH4 release 

from the peatland, but generate low and wet environmental conditions which are 

unfavourable for natural ecosystem recovery (Rensen et al., 2015), thus suggesting these 

impacts may be long-lasting. All seismic lines assessed in this study were approximately 

2m wide and are therefore classified as ‘low-impact’ under current industry and regulatory 

standards. This investigation reveals the true effect of these lines on peatland surface 

conditions and CH4 release, and wider lines are anticipated to cause even greater impacts. 

To conclude, the research objectives posed in this thesis were achieved successfully. UAV data 

was found to be appropriate for modeling peatland terrain, and methods were developed to utilize 

this data to quantify the impacts of seismic lines on a western Canadian peatland ecosystem. The 

potential to use cost-effective UAV platforms to model these complex peatlands opens the door 

for future research on how linear disturbance features are altering these sensitive ecosystems. 

 
4.2 Research Contributions 

Research undertaken in this thesis has resulted in a number of methodological and theoretical 

contributions to the fields of remote sensing and peatland monitoring. Peatlands of western Canada 

are extremely complex ecosystems, and as such are difficult to model. However it is vital to 
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improve the accuracy of estimated peatland carbon stocks and carbon balance models to better 

inform global climate change policies and predictive models. Therefore, the main contribution of 

this research is the first-known spatially explicit quantification of seismic-line impact assessment 

on peatland morphology, hydrology, and GHG flux. As part of this contribution, the demonstrated 

application of UAV technology to successfully derive these estimates is significant, as the 

suitability of these platforms for use in treed bog ecosystems had not previously been assessed. 

The methods developed during the completion of this research are fairly straight-forward, with the 

potential to be applied across a variety of study sites.  

 This research has the potential to assist with the development of provincial legislation 

regarding linear-feature restoration requirements within the Boreal region of western Canada. My 

work shows that seismic lines create lower, wetter areas within the treed-bog system I worked in, 

leading to increased methane release and likely reducing the chance of re-establishing a 

comparable ecosystem (Rensen et al., 2015).  With improved methods of mapping undisturbed 

peatland conditions, clear microtopographic restoration standards could be mandated for disturbed 

Boreal peatlands (ie. minimum microform heights and frequencies) as part of provincial land-use 

guidelines.  Currently, many regional plans which include intents to restore seismic lines within 

Boreal areas are written with a focus on woodland caribou habitat, rather than greenhouse gas 

potential or peatland microtopography (GoA, 2016). As such it appears significant environmental 

factors are being omitted from the legislation which, if included, may ultimately increase the 

chance of successfully achieving overall restoration of ecosystem functions. 

Other contributions include:  
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1. The development of ten methodological tutorials (Appendix A) which were shared 

internally, and used as laboratory material of undergraduate classes. The titles of these 

tutorials are: 

i. Downloading Files from the Trimble R4 or R8 and Determining RTK Accuracies 

ii. Point Cloud Generation in Agisoft PhotoScan 

iii. Re-projecting Point Clouds using LAStools 

iv. Updating Image Pathways in PhotoScan 

v. Extracting Ground from Dense Point Clouds (when the PhotoScan Point 

Classification Tool is Inadequate) 

vi. Converting Ground Point Clouds to DTMs and Model Validation in ESRI ArcMap 

vii. Applying Filters to Masked Images in ENVI 

viii. OBIA in eCognition with Accuracy Assessment in ESRI ArcMap 

ix. GCP Design Considerations – Review of Problems from 2016 Peatlands Research 

Project 

x. How to Bust Clusters in PCI Geomatica 

2. Personally prepared a written summary of the overall peatland research project and 

arranged for it to be showcased in Duck Unlimited Canada’s Wetland Best Management 

Knowledge Exchange, (DU, 2017). 

3. Select material from Chapter 2 was presented at the Earth Observation Summit in Montreal 

on June 21, 2017 (Lovitt et al., 2017b), as well as a second 15 minute oral presentation of 

work completed by a project partner describing the generation and accuracy assessment of 

the DTW surface (Rahman et al., 2017b). 
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4. The published manuscript (Lovitt, Rahman & McDermid, 2017 [Chapter 2]), peer-

reviewed article (Rahman et al., 2017a), and one article currently in review (Lovitt et al., 

2017a [Chapter 3]), represent formal contributions to the literature and broader body of 

knowledge. 

 
4.3 Recommendations for Future Research 

While this thesis represents numerous research contributions, there remains a number of points 

which would benefit from additional analysis and more thorough investigation. The areas of future 

research identified as most important are summarized below. 

 Firstly, alternative methods of filtering trees and other vegetation from the dense point 

cloud should be investigated. During the ground-point extraction workflow (as described in 

Chapter 2) it became apparent that the software packages I used (PhotoScan, LAStools and Cloud 

Compare) struggle in correctly distinguishing true ground points from those representing low-

hanging branches at the edge of tree boundaries. This weakness was attributed to the software 

filtering tools, which rely primarily upon point isolation and elevation-spike thresholds, which do 

not perform well when point clouds are very dense. Had these points been included in the dataset, 

they would have caused an inappropriate localized overestimation of ground-surface elevations 

which would have negatively influenced results. I dealt with this issue through the application of 

an 18-pixel buffer to masked treed areas, but this approach likely also masked out valid ground 

points. The extraction of accurate ground points affects all subsequent steps of analysis, and is 

therefore a crucial step. Furthermore, the current methodology for extracting ground points is 

computationally expensive, as it requires data processing with three separate software packages 
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(PhotoScan, LAStools and Cloud Compare). Therefore, additional research focusing on improving 

dense-point-cloud filtering tools and workflows would also be beneficial.  LAStools has a very 

active user base, with new tool applications being reported and discussed every week. One such 

release (July 4, 2017) described a workflow for correctly classifying excessive low noise in dense 

point clouds (Isenburg, 2017). Although this workflow does not directly address the 

aforementioned issue of limited above-ground vegetation filtering, it does describe methods of 

point filtering based on expected values (ie. searching within specific ranges of accepted ground 

maxima) which could be used to improve vegetation filtering in this work.  

Microform classification methods developed through this research could also be refined 

and improved with further analysis. The simple density slicing approach utilized in this project 

was applied after an assessment of alternate methods, including a combination of spectral and 

elevation data, and object-based image analysis (OBIA). I found that spectral differences between 

hummocks and hollows did not exist consistently across the large study area. Therefore, the RGB 

data did not contribute significantly to microform identification across the bog, and so 

classification was based exclusively upon relative elevation thresholds. Data used in the 

classification workflow was collected in September, which is fairly late in the growing season, and 

produced an orthophoto slightly more blurry than the July data. However, this data was used as 

the July dataset had extremely dark shadows which obscured a great deal of ground in the 

orthophoto. It is likely that enhanced flight-mission planning, designed to capture data in the spring 

under diffuse, bright-light conditions, could address the issue of limited spectral contribution to 

microform classification. This is based on the assumption that spectral differences between 

hummocks and hollows are less obvious later in the growing season (ie. September) than they are 
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in the spring. Additionally, experimenting with different flight parameters such as altitude, overlap 

and sensors (ie. NIR) may improve microform classification results (Lehmann et al., 2016).  

Gathering additional flux measurements over a variety of microform heights would allow 

for greater segregation of microform classes in the MT surface. Incorporating more classes may 

improve CH4 estimates from the MT surface in undisturbed portions of the bog. In particular, 

establishing an appropriate flux to assign to a ‘transitional’ microform class (or ‘lawn’ class) would 

address weaknesses identified in the classification workflow. Similarly, supplementary data could 

be used to assess overall accuracy of both predictive surfaces (MT & DTW), and determine which 

method is superior for estimating CH4 flux. Future research focusing on repeating this study, or 

conducting similar studies, over a variety of peatland types and environmental conditions would 

contribute to a better understanding of Boreal peatland ecosystem function and response to 

disturbances within western Canada. For example, UAV data could be used to estimate emissions 

of other greenhouse gases (ie. CO2), or to investigate vegetation differences along seismic lines 

and other linear features, potentially extending into comparative impact assessments of mineral 

fill linear features (ie. roads and pipelines) vs non-mineral fill linear features (ie. seismic lines and 

power lines).  

This brief summary is by no means a complete review of all potential future research 

opportunities, rather it is meant to showcase points which emerged as a direct result of the 

methodologies developed through this project.  
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Appendix A: Tutorials 

  



A(I) DOWNLOADING FILES FROM THE TRIMBLE R4 OR R8 AND DETERMINING RTK 

ACCURACIES 
 
This tutorial will help you download survey data from the department RTK units 

(Trimble R4 and R8). If you have questions on how to download the files from the lab RTK 
(Hemisphere) please ask Mustafiz. These instructions are partially from Derek and partially from 
my own fiddling so if you find a more streamlined approach please update this file! 
You will be downloading two files from the RTK unit: 

1. A comma delimited file which includes your surveyed data: points, lines and/or polygons 
2. An HTML ‘survey summary report’ file which includes recorded RTK accuracies for 

each of your features during the survey 
On the Trimble Hand-held unit: Export your files 

Step 1: Open your desired file on the handheld unit 

 General Survey > Jobs > Open File 

 

 



 

Step 2: Export the survey data as a .CSV file 

 Jobs > Import/Export > Export fixed format* > CSV** 

*make sure the selected file name matches the file you wish to export 

** you can customize the column your data goes into. The default will give you data in the order: 
Point Name, Northing, Easting, Elevation, Code 

 

 

  

Step 3: Export your survey summary report as HTML 



Jobs > Import/Export > Survey report > HTML 

 

 

On your computer: Download the files 

Step 4: Download files from handheld unit to computer 

1. Plug in the handheld unit to your computer using the cable included in the kit 
2. Navigate to the Trimble unit on your computer, and the job folder which contains 

your file 
3. There should be an ‘Export’ folder, open it and copy or move your desired files to a 

new location on your computer  

 

Step 6: Extract recorded RTK point accuracies to your survey data file (In Excel) 

Accuracies are reported along with a lot of additional information for each point collected 
by the RTK. As far as I know there is no other way to get the estimated accuracies for each point 
other than exporting the survey summary report and using the following formula in Excel which 
I developed last summer. If you come across a better method, please update this file and let the 
lab know. 

1. Open both files in Excel 
a. Combine all RTK points into an excel file if necessary*  
b. Combine all accuracy reports into excel file and unmerge cells 

i. Convert html file to excel  



1. Open HTML > Save as > .xlsx format 
ii. Select all cells in file (ctrl + A) and unmerge 

iii. If necessary use:  
1. Find & Select > Format > Merged Cells > Find All 
2. Select all returned merged cells and hit ‘Merge & Center’ 
3. If merged cells are present the formula in step 3 will not work, so 

use this method to ensure all merged cells are unmerged 
*If necessary. For example: if you are doing this at the end of the summer rather than for each 
downloaded file as you create them during the summer 

2. In your survey data (points) file create two new column entries with meaningful titles to 
represent the reported RTK accuracy in the horizontal and vertical directions.  

a. For example: “Hz_Accuracy_Reported” and “Vt_Accuracy_Reported” 
3. Use Index and Matchup formula combination to find reported Hz and Vt accuracies for 

each point in your survey file 
Formula: 

=INDEX(‘array’, MATCH(lookup_value, lookup_array, match_type)±X) 

Where: 

Array =    Desired column to return values (ex. Horizontal accuracies in accuracy file) 

Lookup_value =   Single cell entry to search for (ex. One point ID) 

Lookup_array =   Desired column to match entry with the lookup_value  

(ex. Corresponding point ID in survey file) 

Match_type =   Type of match, exact match = 0 (represents an exact match) 

±X =    Adjustment to returned cell location  

(ex. +2 = return cell value from searched column which is 2 below the matched cell row 
location [point ID]. Adjust this if your notice the desired accuracy is reported in a 
different location, ie. +3 would return the value in the cell which is three cells below the 
row of the matched point ID) 

Example: 

 

=INDEX('H:\UofC\Data Analysis\7. Validation Point 
Accuracies\sibbald\[sibb_all_accuracies.xlsx]Sheet1'!$F2:$F9000,MATCH(A3,'H:\UofC\Data Analysis\7. 
Validation Point Accuracies\sibbald\[sibb_all_accuracies.xlsx]Sheet1'!$B2:$B9000,0)+2) 

4. Don’t forget to save the entries as numbers once you are sure you have copied the correct 
values. If you leave them as a formula and decide to delete or move the files they 
reference the values will disappear so it’s always best to save them as numbers in your 
survey data file. 

  



A(II) POINT CLOUD GENERATION IN AGISOFT PHOTOSCAN 
 
Files to use with this tutorial (in shared Google drive or use your own data): 
Aerial Photographs        Images folder 
Georeferencing GCP locations (x,y,z)     Georeference.csv 
Validation GCP locations (x,y,z)     Validation.csv 
Google Earth GCP locations to assist with locating   Bog_Site_Lab.kml 
A list of which images show which GCPs     GCP_IMGS.xlsx 
 
 
If you have questions as you go through this tutorial you may reference the Agisoft PhotoScan 
Professional Edition User Manual: http://www.agisoft.com/pdf/photoscan-pro_1_2_en.pdf.  
 
Agisoft PhotoScan Processing Workflow: 
Loading Photos (Estimated Time required: 3 mins) 

1. Select ‘add photos’ from Workflow menu, or click  
2. Browse to the images and upload 
3. Selected photos will appear on the Workspace pane. You can view thumbnails of photos 

by selecting the ‘Photos’ tab at the bottom of the pane. 
Estimating Image Quality (Estimated Run Time: 3 mins) 

1. Navigate to the Photos tab 

2. Change image display to ‘Details’ by clicking  and selecting this view 
3. In the photos pane right click and select ‘Estimate Image Quality….’  

a. Apply the analysis to all cameras 
4. Once complete filter results by ‘Quality’ and delete any images with estimated quality 

<0.5 (threshold recommended in User Manual, may be adjusted as needed) 
a. Low image quality can be caused by high blurriness and over/under exposure. 

Including these images into your dataset will decrease overall model accuracy. 
Align Photos (Estimated run time: 10 mins) 

1. Navigate to the ‘Reference’ tab to view reference details for each image. These data were 
captured by the UAV during flight. Some UAVs are not capable of collecting reference 
data, which affects how you align in PhotoScan.  

2. In the Workflow menu select ‘Align Photos…’ 
a. Accuracy: High 
b. Pair preselection: Reference* 

i. *Reference data is available, if missing you would select ‘generic’  
c. Advanced  Key Point Limit: 400,000 and Tie Point: default 

3. Execute 
Check Camera Alignment (Estimated Time 15mins) 

1. Navigate to Photos tab and sort by ‘Aligned’ 
a. Cameras may not align due to insufficient overlap between images or high texture 

homogeneity. If you discover these issues the best course of action is to collect 
additional data, with either increased overlap or altered flight parameters (ie. 
higher altitude) 

2. If there are a lot of images (ie. 50%) missing alignment (no green checkmark): 
a. Select images which are not aligned 



b. Right click and select ‘Reset Camera Alignment’ 
c. Re-run alignment on whole dataset (follow step 2 from Align Photos instruction 

section) and use the ‘generic’ reference setting 
3. If only a few images are missing alignment, either: 

a. Remove these images by selecting and deleting (ie. if ~3 images don’t align by 
the edge due to low overlap) 
OR (if you think you’ll have time) 

b. Manually assign tie points by: 
i. Select images which are not aligned, Right Click and select ‘Reset Camera 

Alignment’ 
ii. Right click in the photo pane and select ‘Filter Photos by Selection’  

iii. Double click on any image and scroll through them in full screen to see 
why they might not have aligned 

1. ie. low, leafy shrubs obscuring ground, with no clear individual 
tree tops or individual plants to identify will cause issues which 
cannot be addressed with manual tie points 

iv. If the issue is not clear, try assigning manual tie points: 
1. Identify points that you can visually match between photos (tie 

points) 
2. Right click at a tie point and select ‘create marker’ (you can 

rename if you right click on the marker) 
3. Navigate to another image which includes the same tie point and 

right click on the tie point, selecting ‘place marker’ and placing the 
corresponding tie point marker 

4. Place at least 4 markers per photo and find at least 2 of these points 
in neighbouring images which have been correctly aligned to 
assign image projection data 

5. In the Photos pan select your non-aligned photos and right click. 
Select ‘Align Selected Cameras’ 

6. Return to the Model tab to view your results 

7. You can remove the image filter at any time by clicking  
v. Remove any few remaining images you are not able to align  

Geo-Referencing (Estimated Time Required: 30mins – 45mins) 
1. Navigate to the Reference tab and upload your georeferencing GCP data 

‘Georeference.csv’ by clicking  and selecting the file (be sure to match the correct 
import columns with the data you want) 

a. Coordinate system: WGS 84 (EPSG::4326) 
b. Delimiter: Comma 
c. Start import at row: 2 
d. Label: 1 
e. Longitude: 6 
f. Latitude: 5 
g. Altitude: 4 
h. Uncheck “load orientation” as these are ground survey points 

2. Since you have not previously created these markers PhotoScan will ask you if you want 
to create them. Click Yes to All. 



3. Open Google Earth and upload ‘Bog_Site_Lab.kml’ 
a. Turn on: Georeference markers, Site boundary and roadway to orient yourself 
b. Refer to this document when attempting to locate georeferencing GCPs 

4. In PhotoScan: 

a. You can toggle camera positions on and off by clicking  
b. Locate GCP center points in images by: 

i. Select and filter images you believe to capture each GCP location using 

the select tool ( ), right clicking and selecting ‘filter photos by points’ 
(or just scroll through ALL images to get started). Use Google Earth as 
reference in locating GCPs – use features such as seismic lines, the 
roadway and pipeline to orient yourself. 

ii. Scroll through photos by double clicking one and using Page Up and Page 
Down, using the scroll bar on the mouse to zoom in or out 

iii. Once you find a GCP, Right click and select ‘place marker’, placing the 
corresponding marker in the center point of the GCP (or as close as 
possible) 

iv. Avoid marking photos where GCP is extremely skewed unless you are 
unable to locate better quality images as this will increase model errors. 

You can zoom to full image extent quickly by clicking  
v. Once you have located a GCP in at least 2 images, PhotoScan will 

estimate its location. You can then refine your selected images by right 
clicking on the marker in an image, or the Reference pane, and selecting 
‘filter photos by marker’. PhotoScan will then display a list of photos it 
estimates the marker to be in. Go through these images and adjust the 
marker to the center point. For markers to be turned on, they must be 

green ( ) this occurs once you have manually adjusted their location. If 
the flag is not green (ie. grey) the point will NOT be considered in dense 
point cloud generation. 

**If you have difficulty locating the GCPs, open ‘GCP_IMGs.xls’. This document includes a list 
of images which you are able to locate the GCPs in ** 
Optimizing Camera Alignment (Estimated Time Required: 5mins) 
This portion of the workflow is not necessary to produce a dense point cloud. However, it does 
remove high error tie points from the sparse point cloud prior to dense point cloud generation, 
which results in a more accurate model. The following thresholds were developed from data 
collected by an Aeryon Skyranger fitted with an HDZoom30 optical camera (reported 2.9cm 
ground resolution). If your data is of lower quality you may have to lower the thresholds to avoid 
removing too many points. As you proceed through the workflow and select points for deletion, 
ensure they are not concentrated in one spot otherwise you will end up with major data gaps. It is 
up to you to play with the thresholds to determine what is appropriate for your data. 

1. Navigate to the reference tab and uncheck all images (select all, right click and select 
‘uncheck’) 

2. Optimize Cameras using GCPs only by clicking  and running with default settings 
3. Remove high error points by the following processes: 

a. Edit > Gradual Selection > Reconstruction Uncertainty (10) > Ok > Delete ( ) 



b.  
c. Edit > Gradual Selection > Reconstruction Uncertainty (10) > Ok > Delete ( ) 

d.  
e. Edit > Gradual Selection > Reprojection Error (1) > Ok > Delete ( ) 

f.  
g. Edit > Gradual Selection> Projection Accuracy (10**) > Ok > Delete ( ) 

i. ** Do not use this threshold if more than 10% of the points are selected, 
adjust it to select fewer than 10%  

h.  
i. Manually select and delete any obvious outliers (ie. points extremely high or low) 

j.  
Dense Point Cloud (Estimated Run Time: 20mins) 
The following settings are data specific and dependent on your research objectives, you may 
increase the quality setting to ‘High’ but this may also increase the noisy-ness if your dense point 
cloud. If you are working with data from vegetated areas you should either select ‘Mild’ or fully 
disable depth filtering. Depth filtering removes points which PhotoScan deems too far from the 
surface based upon the threshold you have selected. Choosing ‘High’ depth filtering is the most 
stringent threshold and will result in poorly estimated vegetation heights. High depth filtering is 
designed for models of smooth surfaces or items with low anticipated surface variability (ie. 
dinosaur fossils).  

1. From the Workflow menu select ‘Build Dense Point Cloud’: 
a. Quality: Medium 
b. Advanced  Depth filtering: Mild 
c. Execute 
d. You can view the results in the Workspace pane by double clicking the Dense 

Cloud 
2. Export your Dense Point Cloud by right clicking on it in the Workspace pane and 

selecting ‘Export Dense Cloud…’ 
a. Save in .laz file format 

Accuracy Assessment (Estimated Required Time: 5mins) 
PhotoScan already calculates estimated errors for each GCP you used to geo-reference but 

it’s always better to perform an independent test since error should theoretically be 0 at geo-
referencing GCP locations. 

Perform the independent accuracy test: 
1. Upload your validation GCP locations ‘Validation.csv’ into the Reference pane 
2. Manually locate validation points in photos (see step 5 in Geo-referencing section) 

3. In the Reference pane click to see PhotoScan location estimates and  to see 
estimated errors 

4. Export the estimated locations by clicking , saving as .txt and selecting ‘markers’. Be 
sure that ‘save estimated values’ is selected. 

5. Open the .txt file in Excel and view the estimated x, y and z errors. Alternatively, you 
may compare the estimated X, Y, and Z values for each validation point with those found 



in the ‘Validation.csv’ file to manually calculate errors (first converting Lat/Long to 
UTM for comparison). 

Generate OrthoPhoto (Estimated Required Time: 20mins) 
In Workflow menu: 

1. Build mesh: default settings except change Source Data to ‘dense cloud’ 
2. Build texture: default settings 
3. Build Orthomosaic: default settings 
4. Export Orthomosaic as a .tif file, check ‘write BigTIFF file’ 

a. Make a note of the resolution, listed in brackets next to the orthophoto in the 
Workspace pane. 

 
 
  



A(III) RE-PROJECTING POINT CLOUDS USING LASTOOLS 
 
Sometimes when you export a dense point cloud from PhotoScan it will need to be re-

projected. You might already know this if you’re planning to compare it against another dataset 
with a different projection, or it may become obvious when you attempt to view the dense point 
cloud and get something like this: 

 

 
 
Either way, it’s a quick fix. There are two ways to use LAStools to re-project your point cloud: i) 
from the command line, and ii) using the Las2Las GUI. This tutorial will show you how to re-
project a dense point cloud from Lat/Long to UTM coordinates. 
 

Scenario 1: Command Line 
1. From the Start menu of your computer open the command line (type ‘cmd’ into the 

search bar) 
2. Navigate to your LAStools bin folder. Example: cd: C:/LAStools/LAStools/bin  
3. Re-project your data using the Las2Las tool 

a. Code format is: las2las –I “input file name.laz” –odir “output directory” –o 
“output file name.laz” –longlat –target_utm auto 

Example: 
las2las.exe –i “c:\LAStools\LAStools\bin\Sibbald 
Lake\May_Data\sibb_may_DPC_optim.laz” –odir “c:\LAStools\LAStools\bin\Sibbald 
Lake\May_Data” –o”sibb_may_repro_UTM.laz” –longlat –target_utm auto 
 

4. You should now be able to open the re-projected file to make sure it worked. If it did 
not, have a look through the cmd window to see where the error is 

Scenario 2: Las2Las GUI  



1. Navigate to the Las2Las application file in the bin folder and open it 
2. Browse to your desired input file and double click it to input: 

 

3. Select your output directory by clicking  under the ‘output’ menu on the right 
side of the GUI: 

 
4. Give your output file a name in the ‘filename’ line 
5. Expand the target projection menu and select your desired projection etc. and 

precision: 

 
6. Click ‘RUN’ 
7. Once complete, open the output file to make sure it re-projected correctly. If it did 

not, have a look at the cmd window to see what the error might be.  
In either case, you will hopefully end up with something like this: 



 
Instead of what you started with: 

 
 
Alternatively you make use other tools/applications to re-project your data.  
For example pdal (discovered by the lovely Jordan Eamer): 
https://www.pdal.io/workshop/exercises/translation/reprojection.html 
  



A(IV) UPDATING IMAGE PATHWAYS IN PHOTOSCAN 
(A tutorial for non-programmers) 

This is an important step if you wish to share a .psx file with collaborators, or move the 
saved location of your PhotoScan project. If you do not update the image pathways you will run 
into an error (see below) when attempting to access individual images from the Photos tab in 
PhotoScan. This results in PhotoScan loading the thumbnail (super low resolution) rather than 
the high quality image you used for point cloud/orthophoto generation. 
Example Error: 
 

 
 
To update the pathway information directly (not using Python) is simple. Each PhotoScan project 
generates a .psx file and a corresponding .files folder. You will be working in the .files folder. 
 
You will need: 

1. Notepad++ (or similar) 
2. 7zip (or similar) 
3. Knowledge of where the images are now saved so you can update the pathway 

Steps: 
1. In Windows explorer navigate to the frame.zip file for the project you wish to update. 

a. Example: G:\CarmonCreek-Sept2016-FEN-wGCPs-optim.files\0\0\frame.zip 
 

2. In Notepad++ 
a. Open the doc.xml file located within the frame.zip folder 

i. The best way to do this is to copy the document location from your 
windows explorer (step 1) and paste it into Notepad++ open file path 

1. Attempting to open the frame.zip file in Notepad++ directly won’t 
work 

Example: file pathway in Windows explorer to be copied into Notepad++: 

 



File pathway copied into Notepad++, with doc.xml file shown: 

 
b. In the file you will see a bunch of code. You are going to update the photo path 

line: 

 
c. Hit CTRL+H to open the find & replace window 
d. In ‘Find’ line: enter the old image pathway you want to replace 
e. In ‘Replace’ line: enter the updated image pathway (example below) 

 
f. Save document as doc.xml to your Desktop 

 
3. In Windows explorer right click on the frame.zip folder and select:  

a. 7zip>Open Archive  



4. In 7zip rename the doc.xml file to something else (example: doc_old) 
a. You do not want to delete this file in case you make a terrible mistake  

 
5. Drag the updated doc.xml file from your Desktop into the 7zip archive and click ‘YES’ to 

the warning 
 

6. Close 7zip and Notepad++ 
 

7. Open your PhotoScan project and try opening an image in the Photos tab 
a. If it still gives you an error go back and check the photo path code in Notepad++ 

to make sure there are no extra spaces, missing slashes etc. 
  



A(V) EXTRACTING GROUND POINTS FROM DENSE POINT CLOUDS (WHEN THE PHOTOSCAN 

POINT CLASSIFICATION TOOL IS INADEQUATE) 
 

This tutorial will assist you in extracting the ground from a dense point cloud. It is 
important to note that Agisoft PhotoScan includes a classification tool which activates once you 
have finished generating all products (dense point cloud, ortho, mesh, texture etc.). It is located 
under Tools>Dense Cloud>Classify Ground Points. Have a look at the performance of this tool 
before you jump into the following tutorial as it may produce acceptable output for your needs. 
PhotoScan classification tool uses step and angle thresholding to classify ground points.  

 

Assuming you have already played with the classification tool from PhotoScan and found 
it lacking, you may experiment with LAStools and Cloud Compare. LAStools is similar to 
PhotoScan in that it uses step and angle thresholding, however you have many more tools at your 
disposal and have more control over the filtering than in PhotoScan, which is handy for complex 
datasets. 

1. You will need an updated LAStools license in the bin folder to have full access to 
all tools.  

2. You will need a copy of Cloud Compare if not already installed. Free download 
here: http://www.danielgm.net/cc/release/  

 

In this tutorial ‘noise’ refers to all points in the cloud which are not considered ground – 
such as trees/vegetation and actual noise. 

 

 

Step 1. Pre-Noise Filtering (roughly extracting ground points): 

1. Export dense point cloud (DPC) from PhotoScan (after manual removal of clear outliers) 
2. Reproject las file if necessary: Full steps provided in tutorial “Reprojecting Point Clouds 

using LAStools” 
a. Quick guide: 

i. Las2Las: reprojection of DPC into UTM using code: “las2las -i in.las -o 
out.las -longlat -target_utm auto”* 

ii. * use this file for next steps 
Step 2. ‘Noise’ Filtering:  

Alter thresholds as necessary, this workflow is data specific meaning these values may 
not work for your data or for site data collected on different dates. LASground relies primarily 
upon point isolation and positional thresholds (ie. elevation spike) to distinguish ground from 
surrounding points in the cloud. This does not work very well with high density clouds such as 
what you produce from UAV data, hence the need for filtering with Cloud Compare. LAStools 
and Cloud Compare are both open source software packages, meaning tools may have been 
developed in the time since this tutorial was created, and/or other software packages may now 
exist which do a better job of extracting ground from dense clouds. It is worth it to spend some 
time researching current approaches to ground extraction prior to executing this workflow. I 
highly recommend reading the README file for each LAStool before you use it. This will 



explain how the tool works and allow you to better modify the thresholds for your data, 
increasing your efficiency. If at any point a LAStool fails to execute you can refer to the 
command window for an error report. 

Using LAStools: 

1. Lastile: tile size = 550, buffer = 15 
2. Lasground: custom settings: step = 1, bulge = 0.5, spike = 0.3, offset = 0.2, std dev = 3, “-

coarse” added to code, compute height = checked 
3. Las2las: filter = keep_classification_2 
4. Lastile: remove buffer points 
5. Las2las: merge files into one = checked 
6. In Cloud Compare: 

1. Import file from step 7 to Cloud Compare (CC) and allow for data shift 
2. CC statistical outlier removal (SOR) Filter: # of points = 100, std dev = 1.5 
3. CC noise filter: radius = 0.5, max err (abs) = 0.5, remove points = checked 

a. Export filtered files from CC in .las format 
Back to LAStools: 

7. Lastile: tile size = 250, buffer = 15*  
a. *merged file is too large (too many points) to perform step 12 without tiling 

8. Lasview: Unclassify all points (set classification to 1)* 
a. *Perform separately for each tile unless you figure out how to batch 

i. Wait for all points to load in view window before: 
ii. Right Click > reclassify points as > unclassified (1) 

iii. R = registers the change 
iv. Ctrl + S = saves changes to .lay file 
v. Ctrl + A = converts .lay file to .las file 

vi. Wait for message indicating .las file has been written prior to closing view 
window 

9. Lasnoise: step (x,y) = 2, step (z) = 0.5, isolated = 300 
10. Lasground: custom settings: step = 5, bulge = 0.25, spike = 0.25, offset = 0.25, std dev = 

1, ignore points = 7, computer height = checked 
11. Las2las: filter = keep_classification_2 (or drop classifications 1 & 7), drop_z_above_624 

a. Select elevation threshold (ie. 624 for bog or 625 for fen) by comparing outliers to 
known ground points (use ‘I’ in lasview to read x,y,z coordinates for individual 
points) 

12. Lasview: inspect & manually remove outliers 
a. Example of outliers (lingering vegetation): 



 

13. Lastile: remove buffer points 
14. Las2las: merge files into one = checked, target projection = UTM Zone 11, WGS84, 

keep_classification_2, output format = .las 
15. Quickly estimate accuracy of output: lascontrol against validation points 

a. Note: LAScontrol validates based on comparison with TIN surface – use as 
quick estimate only to determine whether workflow tweaks are necessary, 
unless interpolation method is unimportant to your final products 

 

This is the end of the ground point extraction workflow. There are multiple ways to 
convert the cloud into a DTM, see tutorial “Converting Ground Dense Point Clouds to 
DTMs and Validating” for quick summary using ArcGIS and LAStools. I recommend 
ArcGIS for this task, LAStools output for large datasets requires merging in QGIS which is 
time consuming and prone to errors, plus LAStools interpolates using TIN (cannot change) 
which is another reason why ArcGIS is superior as you have more control over interpolation 
method and parameters (ie. resolution). However, it’s always a good idea to have a plan B in 
case there are issues with ArcGIS output. I encourage you to refine this workflow, or develop 
a superior one as new tools are developed. 

 

  



A(VI) CONVERTING GROUND POINT CLOUDS TO DTMS AND MODEL VALIDATION IN ESRI 

ARCMAP 
 

1. Open ArcMap and create new LAS dataset: 
a. Data Management Tools > LAS Dataset > Create LAS Dataset 
b. Input = LAS file from Step 14 in ground extraction workflow 

i. Specify coordinate system 
2. Convert point cloud to Raster: 

a. Conversion Tools > To Raster > LAS Dataset to Raster 
i. Select preferred interpolation method and input cell size to achieve desired 

resolution of Raster (ie. 0.02 = 2cm in UTM coordinate system) 
 

LAStools Method (Not recommended unless ArcMap doesn’t work for some reason):  

1. Input = LAS file output in Step 14 from ground extraction workflow 
2. Lastile: tile size = 550, buffer = 0 (file too large to generate DEM without tiling) 
3. Las2dem: step = 1, kill >100, -elevation, actual values, format = .tif 

a. Note: LAStools generates a DEM using TIN interpolation which may be 
undesirable depending on your project goals 

b. If you do not wish to output TIN interpolated DEM follow ArcGIS workflow 
4. Import tiled las2dem output into QGIS & Merge dataset 

a. Raster > Miscellaneous > Build Virtual Raster (Catalog) > select visible raster 
layers for input > enter output name > Ok 

b. Double check elevations are reported correctly! 
 

Validating Models with RTK Reference Points (ArcGIS) 

1. Input reference points into ArcGIS: Right Click input table > display x,y data 
2. Input Raster (DTM) you wish to assess the accuracy of 
3. Extract Raster values to reference points and export to Excel for comparison: 

a. Spatial Analyst Tools > Extraction > Extract Values to Points 
b. Right click on output in ArcMap > Open Attribute Table 

i. Menu > Export… > Save as .txt 
c. Open .txt file in Excel and convert to useable format: 

i. Select Column 1 in Sheet > Data Tab > Text to Columns 
d. Compare Raster value with reference point RTK elevation value 
e. Calculate stats like RMSE from difference etc. 

  



A(VII) APPLYING FILTERS TO A MASKED IMAGE IN ENVI 
 
Sometimes you need to generate new data for further processing by applying filters to 

masked data. Unfortunately, ENVI does not properly ignore 0 values in the filter calculations, so 
your masked cells are included rather than ignored, skewing output and misrepresenting true 
conditions. To correct this, the wonderful Dr. Mustafiz Rahman created a series of codes which 
you can execute in the IDL window depending on the kind of filter you wish to apply. You can 
run them all or separately by adding lines to specify data location at the beginning of each code, 
and/or ‘end’ commands to stop the process after it completes.  

 
Code 1. Apply a Median Filter to data within DN range 500-800 (excludes masked values ‘0’), 
window size approx. 2m2 (cell size 2cm), and output as tif file: 
 
Pro DefineRef 
 
data = read_tiff("C:\Users\julie.lovitt\FeaureExtraction-FenJuly2016\SeptDTM_MaskedNodata.tif", Geotiff = 
GEO)  
 
W = (size(data))[1] 
print, "width = ", W 
H = (size(data))[2] 
print, "height = ", H 
 
outputMedian = fltarr(w, h)  
for i = 51, W-51 do begin  
  for j= 51, H-51 do begin  
    if data[i,j] gt 500 and data[i,j] le 800 then begin  
      Cdata = data[i-51:i+50, j-51:j+50] 
      location = where((Cdata gt 500 and cdata le 800), Count) 
      ;print, 'number of finite pixels = ', count 
      TrimCdata = Cdata[location] 
      outputMedian[i, j] = median(trimCdata) 
     endif else begin 
      outputMedian[i, j] = data[i, j] 
     endelse 
  endfor 
endfor 
 
write_tiff, "C:\Users\julie.lovitt\FeaureExtraction-FenJuly2016\Bog_Test\SeptDTMRef_Med.tif", outputMedian, 
/float, Geotiff = GEO 
outputMedian = !NULL 
 
Print, "median file created" 
end 
 
 
 
 
  



Code 2. Apply a Mean Filter to data within DN range 500-800 (excludes masked values ‘0’), 
window size approx. 1.5m2 (cell size 2cm), and output as tif file: 
 
Pro DefineRef 
 
data = read_tiff("C:\Users\julie.lovitt\FeaureExtraction-FenJuly2016\SeptDTM_MaskedNodata.tif", Geotiff = 
GEO)  
 
 
outputMean15 = fltarr(w, h) 
for i = 37, W-38 do begin 
  for j= 37, H-38 do begin 
    if data[i,j] gt 500 and data[i,j] le 800 then begin 
      Cdata = data[i-37:i+37, j-37:j+37] 
      location = where((Cdata gt 500 and cdata le 800), Count) 
      ;print, 'number of finite pixels = ', count 
      TrimCdata = Cdata[location] 
      outputMean15[i, j] = mean(trimCdata) 
    endif else begin 
      outputMean15[i, j] = data[i, j] 
    endelse 
  endfor 
endfor 
 
 
write_tiff, "C:\Users\julie.lovitt\FeaureExtraction-FenJuly2016\Bog_Test\SeptDTMRef_Mean15.tif", 
outputMean15, /float, Geotiff = GEO 
outputMean15 = !NULL 
 
Print, "mean 1.5 file created" 
end 
 
  



Code 3. Sort data values within filter window and drop outliers (top 100, bottom 100) before 
applying a Mean Filter to data within DN range 500-800 (excludes masked values ‘0’), window 
size approx. 2m2 (cell size 2cm), and output as tif file (note: this one takes days to run if you 
apply to a large dataset): 
 
Pro DefineRef 
 
data = read_tiff("C:\Users\julie.lovitt\FeaureExtraction-FenJuly2016\SeptDTM_MaskedNodata.tif", Geotiff = 
GEO)  
  
 
outputMean2trim = fltarr(w, h) 
for i = 51, W-51 do begin 
  for j= 51, H-51 do begin 
    if data[i,j] gt 500 and data[i,j] le 800 then begin 
      Cdata = data[i-51:i+50, j-51:j+50] 
      location = where((Cdata gt 500 and cdata le 800), Count) 
      ;print, 'number of finite pixels = ', count 
      TrimCdata = Cdata[location] 
      sortLoc = Sort(TrimCdata) 
      SortedTrimCdata = TrimCdata[sortLoc] 
      if count gt 250 then begin 
        SampleCdata = SortedTrimCdata[100:count-101] 
        outputMean2trim[i, j] = mean(SampleCdata) 
      endif else begin 
        outputMean2trim[i, j] = mean(SortedTrimCdata) 
      endelse 
     endif else begin 
      outputMean2trim[i, j] = data[i, j] 
     endelse 
  endfor 
endfor 
 
 
write_tiff, "C:\Users\julie.lovitt\FeaureExtraction-FenJuly2016\Bog_Test\SeptDTMRef_Mean2Trim.tif", 
outputMean2trim, /float, Geotiff = GEO 
outputMean2trim = !NULL 
 
Print, "processing complete" 
end 

 
 

  



A(VIII) OBIA IN ECOGNITION WITH ACCURACY ASSESSMENT IN ESRI ARCMAP 
 
This tutorial will provide a starting point for anyone interested in performing feature 

extraction (by developing a rule set) in eCognition, and subsequently assessing classification 
accuracy in ArcMap. Data used here includes an RGB orthophoto and specialized elevation data 
which was created for use in identifying Hummocks from Hollows across a peatland of Northern 
Alberta. Additionally, the data used here includes RTK points used in the accuracy assessment. 
As a result, there was no need to select ‘training sites’ for the accuracy assessment. This may be 
different for you depending on your data. 

 

Step 1: Building a Ruleset in eCognition 

1. Watch the YouTube videos from Jarlath O’Neil-Dunne, especially this one 
(https://www.youtube.com/watch?v=QEDGz749lwc&t=398s&list=PLG0a9U3eef7ogzq
mj2PwTy2splFdHKe7i&index=1) and follow along with your data to develop rules: 

a. Using a subset of your data if it is a large dataset, tweak your rules until you 
believe your results are adequate for full site classification 
 

b. Try changing the weighting of bands in your segmentation to improve your output 
segments (ie. if your data is: R,G,B,Elevation and classes are clearly visually 
apparent in the green band, you may change weights to something like: 1,3,1,1) 

 

c. eCognition allows you to develop a wide variety rules including: spectral, 
proximity, elevation etc. The rules will be specific to your data and research 
objectives, therefore this tutorial won’t go into great detail. Jarlath does an 
excellent job in his youtube videos. 
 

d. Once you are happy with your classes, merge your class polygons to reduce 
export time  

i. You will need to create merge rules for each of your classes, if you just 
run one it will merge all polygons regardless of class so you’ll end up with 
one large polygon 

 
e. Export vector layers for each class with meaningful names like 

‘bog_sept_ruleset1_Trees’  
 

Step 2a: Assigning Class Results to your Validation Points for Assessment 
This assumes you have RTK validation points available for all classes 

In ArcMap:  

1. Open the polygon layers individually and create new field to list class name 

a. Right click on layer > Open Attribute Table > Menu ( ) > Add Field > Type 
field name (ie. ‘Class’) > type = text > OK 

b. Right click on newly created field in Attribute Table > Field Calculator > enter 
class name (ie. “Trees”) > OK > Close Attribute Table 

i. Repeat for each class vector you have imported 



 
2. Merge Class polygons into one file 

a. ArcToolbox > Data Management Tools > General > Merge  
 

3. Convert merged polygon to Raster 
a. ArcToolbox > Conversion Tools > To Raster > Feature to Raster > field = Class > 

output cell size = desired resolution 
 

4. Assign Raster values to your validation points 
a. ArcToolbox > Spatial Analyst Tools > Extraction > Extract Values to Points 

 

Step 2b: Select Validation Points (training sites) for Accuracy Assessment  

Complete this step if you don’t have RTK point data for all classes 

1. Watch & follow this YouTube Video: https://www.youtube.com/watch?v=FaZGAUS_Nlo 

 

Step 3: Assess the Accuracy of your Classification 

In Excel:  

1. Compare the raster class to the field assigned class for each point and generate a 
confusion matrix 
 

2. Calculate the kappa statistic  
a. Online calculator: http://vassarstats.net/kappa.html  

 
3. Return to your ruleset if necessary to improve your classification accuracy 

 
4. If you are satisfied and have been working with a subset, apply the ruleset to the full 

dataset and repeat accuracy assessment. You might find the results are surprising and 
need to tweak some rules that don’t appear to work well across the entire study area. 

 

  



 

A(IX) GCP DESIGN CONSIDERATIONS – REVIEW OF PROBLEMS FROM 2016 PEATLANDS 

RESEARCH PROJECT 
 
This document will provide you with some image comparisons of GCPs used in the 2016 

peatlands research project. Hopefully this will help you select the proper GCP design for your 
flights and you can avoid problems we ran into. Conclusions and recommendations are 
summarized after each comparison. 
 
Permanent GCP (pGCP) Specs: 10 installed across site 
Size: 25cm2 

Materials: steel plate, poorly painted by summer students (unclear middle point) with different 
coloured corners and letters A – J for easy identification (theoretically) 
Fastening Design: four 2m long metal rods pounded through peat to underlying mineral layer via 
rubber mallet, fastened to GCP corners through pre-drilled holes and wing-nuts  

 
Example: pGCP Paint Design (No Stencil Used) 

 
 
Temporary GCP (tGCP) Specs: 50 installed over 3 trips to site 
Size: 25cm2 

Materials: Corrugated plastic board and spray paint (Rona) 
Fastening Design: one 9’ nail through a corner of the GCP into the ground (Home Depot) 

 
Example: tGCP Paint Design (Stencil Used) 

 
 
Flight Plan Details: 
UAV: Aeryon Scout with HDZOOM30 OR EBee with Canon S110 RGB (will be listed by 
image) 
Altitude: 110m (Scout) OR 70m (EBee) 
Desired Res & Overlap: 2cm, 80% (fore), 60% (side) 
Weather Conditions: described for each comparison 
Comparison 1a: pGCPs – Full Sun vs Shade Conditions 
UAV: Aeryon Scout with HDZOOM30 
Flight Date: July, 2017 



 

Conditions: Full sun, two flights conducted (morning and afternoon) to capture different shadow 
angles 

pGCP: Deep Shadows 

 
 

pGCP: Full Sun 

 
Problem: Steel surface of permanent GCPs highly reflective, causing washout and inability to 
accurately locate center point. 
  



 

Comparison 1b: tGCPs – Full Sun vs Shade Conditions 
Same flight conditions as 1a 
GCP material: RED corrugated plastic board with black spray paint 
 

tGCP: Deep Shadows 

 
 

tGCP: Full Sun 

 
 
Result: Temporary GCPs center point more clearly visible in full sun conditions as compared to 
steel plate permanent GCPs. 
  



 

Comparison 2: pGCP vs tGCP Painting Design 
UAV: EBee with Canon S110 RGB 
Flight Date: October, 2017 
Flight Conditions: Overcast, 2-3cm snow on ground 
Same zoom level shown in images below 
 

pGCP in field (this is the GCP displayed on page 1): 

 
 

  



 

tGCP (RED corrugated plastic board with black spray paint): 

 
 
  



 

Both in Same Image: 
(Poor performance of pGCP not due to distortion as it is closer to center of image) 

 
 
 
 
Result: Effort should be taken to paint GCPs as clearly as possible to provide a solid center point 
for locating. Use a stencil to get clean edges and pick colours with good contrast! 
 
 
  



 

Comparison 3: tGCPs Design – RED vs WHITE Corrugated Plastic Board with black 
spray paint 
Notes: WHITE board spray painted fluorescent orange (purchased when RED unavailable) ex. 
Page 1. WHITE tGCPs had not been installed at site until August which is why there are images 
from both flights. 
 
UAV: EBee with Canon S110 RGB 
Flight Date: May & August, 2017 
Flight Conditions: Overcast with a brief window of full sun (August), high clouds, bright (May) 

 
RED Corrugated Board: Full Sun 

 (Flight – May, 2017) 

 
 

RED Corrugated Board: Shade  
(Flight – August, 2017) 

 
WHITE Corrugated Board: Full Sun 

(Flight – August, 2017) 



 

 
 

WHITE Corrugated Board: Shade 
(Flight – August, 2017) 

 
 
Result: Don’t use white corrugated board for small GCPs OR use a different colour of spray 
paint on them (not fluorescent orange), and ensure the paint is durable to last wear and tear 
through summer use. 



 

Comparison 4: tGCPs Design – RED corrugated board in Red Edge Imagery 
UAV: EBee with Canon S110 RE 
Flight Date: May, 2017 
Flight Conditions: High clouds, bright indirect lighting 
 

tGCP: RED corrugated plastic board 
 

 
 

Result: Don’t use red plastic GCPs if you plan to collect red edge imagery. They are extremely 
difficult to locate in vegetated areas.  

  



 

A(X) HOW TO BUST CLUSTERS IN PCI GEOMATICA 
 

*Always save files with clearly named titles and checkmark the Output save file box* 
 

 
 

  
You can find all applications in Geomatica’s ‘Algorithm Librarian’ (Tools>Algorithm Librarian) 
     

1. Create mask of class you want to bust (using THR: input = unsupervised classification 
layer, parameters: min & max = class you are interested in (ie. 2 and 2 if you want to bust 
class 2), complement mode should be OFF = all values within class = DN of 1, all values 
outside class = DN of 0. (If you want to run opposite turn ON, class =0, surrounding =1) 

 
2. Make sure that the produced mask (bitmap) is saved under the image file in Files and 

Maps tabs (Right click on bitmap mask>Export(save as)>To existing file>*your image 
file) 

 
3. Rerun unsupervised classification with bitmap applied in drop down: 

 

 
 

4. Now you have your busted class layer! Toggle between image and layer to ensure it is the 
class you want. Edit PCT to view ‘random’ to make sure it has busted the layer properly. 

   To merge this busted layer into your original classification: 
 



 

1. REC: Create Recode-LUT Layer (using busted class layer, assigning new values which 
don’t occur in original classification (higher values)) Check Log for success of run. This 
creates a look up table with the new class values 

a. For example (class values renamed to 21, 22…etc.) 
 

 
 

2. After running, rename layer in map and file tabs if necessary – might still say ‘new 
layer’ in title which can become confusing 
 

3. LUT: Image Enhancement via Lookup Table (input raster = busted layer, LUT = the one 
you created in REC), select Viewer-PCT, make sure to save the output file (browse if 
necessary) Check Log for success of run. 
 

4. Now you have created a layer with the new recoded class values! But it still needs to be 
joined with the original classification 
 

5. Raster Calculator: View> Advanced, Categories>Extreme:  
 

a. Double click ‘Max(a,b)’, in the space of ‘a’ select the original classification layer 
from the list, in the space of ‘b’ select the recoded busted cluster classification 
layer from the list of layers 
 

b. Save file to original image layer (same file as what you have been working with) 
and select ‘new layer’ to produce a new layer (might need to be renamed if it says 
‘empty’ or ‘new layer’ after running) 

 
6. Now you have a layer which includes your original classification PLUS the busted class! 

 
7. Change view (edit PCT) to display layer as ‘random’ to make sure you have all the 

different classes 
 

8. Double check by looking at the histogram to make sure it shows your recoded values 
 

 


